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Este texto está dirigido a estudiantes e investigadores que se inician en 
la simulación de huesos para aplicaciones en Biomecánica, utilizando software 
gratuito. La motivación surge de la enseñanza de esta disciplina en el ámbito 
universitario y de la experiencia previa del autor en el área. Si bien existen 
herramientas computacionales comerciales que facilitan el desarrollo de modelos 
óseos sofisticados, frecuentemente el costo de las licencias impone una barrera 
importante en el desarrollo de la ciencia. Convencido de que también es posible 
desarrollar investigación avanzada utilizando software gratuito, este libro pretende 
ser una guía de iniciación para las personas sin experiencia interesadas en el tema.

El primer capítulo introduce al lector en los aspectos teóricos básicos de la 
simulación en general y de los huesos en particular. El segundo capítulo expone las 
fases para el desarrollo de un modelo personalizado de elementos finitos de huesos, 
introduciendo la teoría específica requerida en cada sección y las herramientas 
computacionales gratuitas que se pueden emplear. Los capítulos subsiguientes 
presentan un estudio de caso detallado, guiando al lector a través de cada paso en 
la construcción de un modelo, desde el procesamiento de imágenes médicas hasta 
la interpretación de los resultados de la simulación. El tercer capítulo se centra en 
la primera fase, que concluye con la generación de una malla de elementos finitos. 
En este capítulo también se encuentra el enlace a un repositorio con la información 
necesaria para que el lector pueda reproducir el estudio de caso desde el principio o 
desde etapas intermedias. En el cuarto capítulo se detalla el proceso de configuración, 
resolución y visualización de los resultados de un modelo homogéneo. Finalmente, 
en el último capítulo, se describe cómo extraer las propiedades elásticas del tejido 
óseo a partir de la tomografía, y cómo configurar, resolver y visualizar los resultados 
de un modelo heterogéneo.

Marco Antonio Ciaccia-Sortino
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1.	 INTRODUCCIÓN AL 
MODELADO Y SIMULA-
CIÓN DE HUESOS

Los modelos de huesos son 
herramientas empleadas para proveer 
soluciones a algunas necesidades asociadas 
al soporte de cargas por parte de humanos y 
animales. El desarrollo de estos modelos es 
una actividad de la biomecánica, que es una 
rama de la bioingeniería en la que se integran 
conocimientos de mecánica, entre ellos 
estática, dinámica y mecánica de materiales, 
y de medicina, como anatomía y fisiología. En 
su concepción más amplia, cualquier ser vivo 
puede estudiarse mediante la biomecánica, 
pudiendo abarcar la cinemática y la cinética de 
los cuerpos o sus partes, el comportamiento 
mecánico de sus tejidos blandos y duros, y 
la transferencia de masa y energía dentro de 
los organismos [1]. En este texto solamente 
se considerarán cargas estáticas y se hará 
referencia a animales vertebrados, con mayor 
énfasis en humanos, por lo que el término 
hueso se refiere a un componente duro o rígido 
del esqueleto.

Los ámbitos principales de la 
biomecánica de los que surgen las necesidades 
que requieren modelos de huesos, algunos 
aplicables solo a los humanos y otros extensibles 
a los animales, son la biomecánica médica, 
especializada en obtener soluciones para las 
patologías que aquejan al cuerpo; la biomecánica 
forense, que estudia las lesiones causadas por 
impactos, sobrecargas, y otros incidentes sobre 
el cuerpo; la biomecánica fisioterapéutica, 
cuyo objetivo es compensar o remediar el 
funcionamiento deficiente del sistema músculo 
esquelético; la biomecánica deportiva, con la 

que se analiza la práctica deportiva para mejorar 
el rendimiento del atleta y prevenir la aparición 
de lesiones, y la biomecánica ocupacional, que 
estudia la interacción mecánica entre el cuerpo 
y los elementos pertenecientes a los distintos 
ambientes en los que se desenvuelve.

Independientemente de los motivos 
que conducen a un investigador a trabajar 
con huesos, es necesario que los modelos 
cumplan con ciertos requerimientos mínimos 
para que los resultados sean significativos 
para la investigación. El más básico es que 
sean anatómicamente consistentes, en lo que 
respecta a la morfología, tamaño, orientación 
y posición del hueso con respecto a otros 
órganos. Dependiendo de los objetivos de 
la investigación, también es necesario que 
tengan un comportamiento mecánico análogo 
al del hueso real. Este requisito es uno de 
los más difíciles de satisfacer, ya que existen 
varios factores cuya determinación puede ser 
compleja o directamente imposible de lograr. 
En este capítulo se exponen resumidamente 
algunos conceptos básicos sobre modelado 
de huesos con énfasis en el aspecto numérico, 
incluyendo las condiciones de contorno y la 
biomecánica del hueso. También se establecen 
las propiedades elásticas del tejido óseo que 
se utilizarán en los capítulos posteriores. Los 
lectores que no tienen conocimientos previos 
sobre estos temas se pueden beneficiar de la 
lectura de este capítulo.

En el capítulo 2 se expone un flujo de 
trabajo para la construcción de un tipo concreto 
de modelo de hueso, específicamente modelos 

numéricos personalizados para simulación 
mediante el método del elemento finito 
(MEF), que comprenden tanto la geometría 
como el comportamiento mecánico de los 
tejidos. El término personalizado se refiere a 
que los modelos se desarrollarán a partir de 
imágenes médicas de un individuo particular. 
Si bien existen herramientas informáticas 
comerciales que facilitan este trabajo, como 
Mimics®, Amira™ y Simpleware, entre otros, 
es muy frecuente que los costos de las licencias 
impidan su adquisición.Por esta razón, algunos 
investigadores desarrollan software propio en 
al menos una parte del proceso de creación 
de los modelos [2]–[4], pero en general estos 
programas no están disponibles para uso 
público, el desarrollo es esporádico, carecen 
de soporte y la interfaz es rudimentaria. Para 
eludir estos inconvenientes se utilizarán 
programas gratuitos disponibles en Internet, 
tanto de código abierto como cerrado, que han 
sido previamente validados y con una interfaz 
de usuario que provee una experiencia de 
usuario al menos aceptable.

 1.1	  Tipos de modelos óseos
Existen varias formas de obtener 

modelos de huesos, cada una con características 
que pueden clasificarse como ventajas o 
desventajas dependiendo del objeto de la 
investigación. Por ejemplo, para comprobar 
que una placa para reducción de fracturas se 
adapta a la morfología del hueso para el cual 
fue diseñada, bastará con que el modelo tenga 
el tamaño y la forma correctos. Si el objetivo es 

1.   INTRODUCCIÓN AL MODELADO Y SIMULACIÓN DE HUESOS



2

saber si un hueso se fracturará al ser sometido 
a cierto impacto, además de los aspectos 
geométricos deberá contar con un modelo de 
daño mecánico apropiado. Como ejemplo final, 
para predecir cómo será la interacción entre 
el hueso y una prótesis interna, es necesario 
contar con representaciones precisas del 
comportamiento mecánico de los diferentes 
tipos de tejidos que conforman el hueso. En [5] 
se provee una guía en cuanto a los factores que 
deben considerarse para seleccionar un modelo 
de hueso. Los principales tipos son:

1.1.1	  Modelos sintéticos
Son representaciones artificiales 

que se fabrican con una espuma rígida de 
poliuretano o con materiales compuestos. Los 
modelos básicos hechos con espuma, como 
los mostrados en la figura 1.1, se utilizan para 
educación en salud y prácticas de instalación 
de placas y prótesis para estudiantes de 
medicina, entre otros usos.

Figura 1.1. Modelo sintético de la articulación de 
la rodilla.

Imagen de MOHLEAOSONDWN 23001

1MOHLEAOSONDWN 2300, CC BY-SA 4.0, https://creativecommons.org/licenses/by-sa/4.0, via Wikimedia Commons.

Figura 1.2. Ensayo mecánico de un fémur humano 
instrumentalizado para la validación de un modelo 
de elementos finitos.

Imagen modificada de [11].

La principal ventaja de estos modelos 
es que tienen el comportamiento mecánico 
más parecido posible al del hueso vivo; sin 
embargo, se descomponen rápidamente luego 
de extraídos del cuerpo donante, lo que tiene 
como consecuencia que sus propiedades 
pueden cambiar significativamente con el paso 
del tiempo. Para reducir este efecto existen 
protocolos de conservación que retrasan la 
degradación de los componentes orgánicos 
hasta el momento de las pruebas [12]. Una 
desventaja adicional desde el punto de vista 
de tiempos y costos es que, para experimentar 
con huesos de cadáveres humanos o de 
animales, se requiere la autorización de un 
comité de ética para investigación biomédica. 
Este aspecto puede ser incluso una dificultad 
insalvable porque en muchos países no 
existen este tipo de comités o no tienen los 
protocolos específicos para procedimientos de 
experimentación con cadáveres.

En el ámbito de la investigación 
experimental se han construido modelos 
más sofisticados que reproducen con mayor 
fidelidad el comportamiento mecánico de los 
huesos reales para poder realizar ensayos 
cuyos resultados sean extrapolables a los 
órganos reales. Para ello se han desarrollado 
espumas rígidas con técnicas avanzadas que 
imitan las propiedades de los huesos en escalas 
macroscópica [6], [7] y microscópica [8], así 
como técnicas de manufactura aditiva, más 
recientes, que imitan las variaciones de densidad 
del tejido óseo o incluso la microestructura 
del hueso [9]. Las ventajas de estos modelos 
incluyen la reducción de los costos y tiempos 
de experimentación, la alta disponibilidad 
de especímenes para pruebas, y que hacen 
innecesaria la autorización de un comité de ética 
para investigación biomédica. La desventaja 
principal es que aún no se reproducen con 
exactitud todas las propiedades mecánicas del 
tejido óseo, como la resistencia a la torsión, 
la variabilidad entre especímenes [10] y la 
acumulación de daño por cargas cíclicas [7].

1.1.2	   Modelos orgánicos
Son órganos reales que se emplean 

como aproximaciones de los huesos que se 
desean estudiar. Por ejemplo, la producción de 
una nueva placa para reducción de fracturas, 
que se venderá al público en general, tiene 
varias etapas de validación, entre las cuales 
se puede incluir su instalación y prueba en 
un hueso extraído de un cadáver, humano o 
animal, que es el principal ejemplo de modelo 
orgánico. Así mismo, es común que se utilicen 
en ensayos mecánicos, como se muestra en la 
figura 1.2, ya que no se pueden realizar in vivo.
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respuesta al problema investigado. Dependen 
completamente de resultados experimentales, 
como las propiedades mecánicas de los tejidos, 
y la posición, dirección y magnitud de las cargas 
fisiológicas, por lo que es importante investigar 
fuentes de datos confiables. La validación de 
las simulaciones también puede convertirse 
en un desafío, a menos que se utilicen modelos 
estandarizados. En caso contrario, los valores 
de desplazamientos y cargas que producen 
fracturas pueden compararse con las obtenidas 
en modelos orgánicos que, por las limitaciones 
expresadas en la sección 1.1.2, podrían 
producir diferencias difíciles de justificar. En 
la figura 1.3 se muestra la distribución interna 
del índice de falla (IF) en un modelo numérico 
de fémur para tres criterios de falla distintos. 
El índice de falla es el inverso del factor de 
seguridad, por lo que se pronostica fractura si 
se cumple que IF≥1.

1.1.3	  Modelos numéricos
Son representaciones matemáticas, 

generalmente desarrolladas y manipuladas 
usando computadoras, que resultan de aplicar 
algún método numérico validado, como el de 
elementos finitos o el de volúmenes finitos. 
Los huesos, y los elementos biológicos en 
general, presentan algunos aspectos que al 
tratar de trasladarlos a un modelo numérico 
pueden ser más desafiantes de representar 
que con huesos sintéticos. La geometría de los 
huesos, en particular, no es fácil de modelar 
empleando formas geométricas comunes o 
sus combinaciones, puesto que en general 
los huesos presentan superficies curvas no 
regulares. Existen algunos modelos genéricos, 
como las geometrías estandarizadas de fémur 
presentadas por Viceconti et al. [13], [14], que 
proporcionan una plataforma general para 
facilitar la comparación de las metodologías 
utilizadas en experimentos in vitro en 

diferentes investigaciones, como las mostradas 
en [15], [16].

Los modelos numéricos poseen ventajas 
importantes. Entre las principales se encuentra 
que permiten modelar diferentes casos de carga, 
incluso los que no se pueden reproducir en 
una máquina de ensayos, por lo que es factible 
representar actividades deportivas y accidentes 
automovilísticos, entre otros. También se 
pueden cambiar las propiedades mecánicas de 
los materiales para simular huesos en diferentes 
estados: sanos, con patologías, adultos, jóvenes, 
etc. Su desarrollo tiene un costo económico 
relativamente bajo, aunque podría consumir 
un tiempo considerable, dependiendo de la 
tecnología empleada y de la fidelidad requerida. 
Finalmente, no se requiere la autorización de un 
comité de ética para desarrollarlos.

Estos modelos tienen algunos 
requerimientos que se deben satisfacer 
para obtener resultados válidos como 

Criterios de falla: izquierda, esfuerzo principal máximo (Rankine); centro, deformación principal máxima (Saint Venant); derecha, energía de distorsión 
máxima (von Mises)

Figura 1.3. Distribución del índice de falla según criterios diferentes en un modelo de elementos finitos de la región proximal del fémur.
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 1.2	  Aspectos de una simulación mediante 	
	  el método del elemento finito

Una simulación mediante el MEF 
consiste, a grandes rasgos, en la solución de un 
modelo numérico discretizado que caracteriza 
a un sistema físico. Para representar el sistema 
físico se acoplan al menos tres modelos 
diferentes: uno para la geometría, otro para 
el comportamiento físico del material, y otro 
para las condiciones de contorno; los sistemas 
más complejos probablemente necesiten 
integrar modelos adicionales. La definición de 
estos modelos requiere considerar los factores 
que se detallan en las siguientes secciones, de 
forma que se construyan modelos consistentes 
con el problema que se está estudiando.

Algunos estudios simulan la estructura microscó-
pica de fragmentos de tejidos, mientras que otros 
estudios los simulan macroscópicamente, como 
parte de un órgano.

Figura 1.4. Niveles funcionales de la simulación 
numérica en el contexto de los seres vivos.

Los modelos constitutivos aplicables a la simulación de huesos son los de sólidos continuos.

Figura 1.5. Clasificación de los fenómenos y las físicas involucradas que se pueden simular 
numéricamente.

1.2.1	  Escala
Es el tamaño relativo del dominio de la 

simulación con respecto al objeto de estudio, 
y puede abarcar desde lo microscópico hasta 
sistemas macroscópicos multicomponentes, e 
incluso sistemas multiescalas. En la figura 1.4 
se muestran los niveles por escalas dentro del 
contexto biológico. Los huesos son órganos, por 
lo que su simulación se clasifica como de escala 
macroscópica.

1.2.2	  Objeto de estudio y física involucrada
Un sistema puede ser analizado desde 

diferentes enfoques, dependiendo del problema 
investigado. Por ejemplo, al estudiar una arteria 
se puede simular el comportamiento mecánico 

de sus paredes o el flujo de la sangre en su 
interior, y también la interacción entre el 
fluido y las paredes arteriales. En el primer 
caso se empleará mecánica de sólidos, en el 
segundo se necesita mecánica de fluidos, y en 
el tercero un acople entre ambas mecánicas. 
Incluso podría agregarse el efecto químico 
de alguna medicina presente en la sangre. 
Cada tipo de mecánica requiere modelos 
diferentes, por lo que es importante definir 
con exactitud qué física está involucrada 
en la simulación del objeto de estudio. En 
la figura 1.5 se muestra un esquema de las 
físicas que se pueden simular con modelos 
numéricos.
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Figura 1.6. Clasificación de las condiciones de contorno e iniciales para una simulación numérica.1.2.3	  Condiciones de contorno e iniciales
La definición de las condiciones de 

contorno, e iniciales si el problema depende del 
tiempo, permitirá obtener el comportamiento 
del sistema en la parte interna del dominio. 
Es común que las primeras simulaciones 
de un modelo arrojen resultados erróneos 
precisamente por la definición incorrecta de 
las condiciones de contorno o iniciales. En la 
figura 1.6 muestra su clasificación con base en 
la física involucrada y el objeto de estudio.

1.2.4	  Métodos numéricos
Existe una gran variedad de métodos 

numéricos utilizados para modelar sistemas 
físicos. Los más conocidos, como el método de 
elementos finitos y el de volúmenes finitos, son 
los que tienen más tiempo en desarrollo, sus 
formulaciones matemáticas están consolidadas 
y se encuentran implementados en una extensa 
oferta de programas computacionales. También 
son los métodos más generales, en el sentido en 
que se pueden utilizar para simular una amplia 
cantidad de problemas físicos.

Otros métodos, menos extendidos, 
se han desarrollado para satisfacer 
requerimientos que las formulaciones más 
generales no pueden cumplir, como mayor 
eficiencia (menor consumo de recursos 
computacionales o de tiempo), modelamiento 
de físicas específicas, u obtención de resultados 
más detallados para un problema particular. 
Los métodos espectrales y de descomposición 
de dominios son ejemplos de este tipo de 
métodos, y son más difíciles de encontrar 
implementados en software de manera general.

La selección del método numérico 
dependerá principalmente de su aplicabilidad 
al problema que se desea resolver, y en 
menor medida a la disponibilidad de su 

Figura 1.7. Algunos tipos de métodos numéricos que se pueden emplear para simular 
problemas físicos.
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implementación en un software ya validado. 
La figura 1.7 muestra una clasificación parcial 
de los tipos de métodos numéricos según sus 
enfoques.

1.2.5	  Plataforma computacional
La precisión de los resultados 

obtenidos con cualquier método numérico 
mejora al reducirse el tamaño del elemento 
base de la simulación, y esto tiene como 
consecuencia el incremento de la cantidad de 
datos y operaciones necesarias para calcular 
las soluciones. En consecuencia, los programas 
y las computadoras son, actualmente, 
elementos indispensables en la simulación 
numérica de problemas industriales o 
científicos. La selección del software pasa por 
dos consideraciones principales: la relación 
costo/beneficio de la solución del problema, y 
la confiabilidad del programa.

Software comercial

En general, este tipo de programas 
es costoso porque es validado estrictamente, 
tiene capacidades amplias, interfaces de 
usuario refinadas y excelente soporte técnico. 
Las empresas adquieren licencias comerciales 
solamente si esperan obtener beneficios 
económicos que compensen la inversión. Los 
centros de investigación privados, estatales 
y educativos también adquieren licencias 
comerciales o educativas para contar con 
herramientas confiables que respalden sus 
investigaciones. Se debe tomar en cuenta que, 
en general, el software comercial funciona 
como una caja negra porque no se informa 
al usuario el detalle de las teorías, métodos y 
procesos internos del programa.

Figura 1.8. Tipos de software para la creación y solución de los modelos simu-
lación numérica.

Software gratuito

Son los programas que no requieren 
pago para su utilización. Pueden ser de código 
cerrado o abierto. Los programas gratuitos 
cerrados comparten con los comerciales el 
modelo de caja negra, y comúnmente generan 
ingresos por medio de la comercialización de los 
servicios de capacitación y soporte técnico, o de 
la venta de publicidad o de datos personales. En 
los últimos dos casos no son realmente gratuitos, 
pero no se pagan con el dinero del usuario. 
Este tipo de software en general tiene menos 
capacidades, interfaces de usuario más toscas y 
ha sido validados con menos rigurosidad que sus 
equivalentes comerciales. En ocasiones tampoco 
cuentan con soporte técnico, más allá de un 
manual de uso y posiblemente una comunidad 
de usuarios. Los programas de código abierto 
comparten casi todas las características de los 
programas cerrados, pero la diferencia y ventaja 
principal es que el código es accesible al usuario. 
Esto permite que se pueda mejorar y corregir, 
pero más importante, agregar capacidades que 
se requieran para la simulación que el software 
original no incluye.

Software de desarrollo propio

Son programas realizados por 
investigadores para obtener soluciones que 
no pueden lograr con otro tipo de software. Se 
crean para implementar métodos novedosos 
o para complementar el software comercial o 
gratuito ya existente. Rara vez son programas 
completos, frecuentemente son solo rutinas 
que interactúan con otros programas a través 
de interfaces de programación o mediante 
intercambio de datos en archivos. Por 
ejemplo, si se desarrolla una nueva teoría 
de falla para materiales frágiles y se desea 
compararla con otras existentes, se podría 
programar una rutina en cualquier lenguaje 
que tome los esfuerzos o las deformaciones 
calculadas con un programa de análisis 
estructural, guardados en un archivo en disco, 
y calcular los factores de seguridad con la 
nueva teoría.  En la figura 1.8 se sintetizan los 
tipos de software según el tipo de desarrollo 
y el costo para el usuario.
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Computadoras personales y 		
	   estaciones de trabajo

El tipo y configuración de las 
computadoras están asociados al tamaño de 
los modelos por resolver y a los requerimientos 
del software de simulación que se ejecutarán. 
Las computadoras personales de escritorio 
o portátiles se pueden usar para obtener la 
solución de problemas pequeños y medianos 
en un tiempo aceptable. Las computadoras 
denominadas “Estaciones de trabajo” pueden 
ser similares en apariencia a las computadoras 
personales, pero sus fabricantes proveen 
una certificación de compatibilidad 
entre el hardware, los controladores de 
dispositivos y los programas especializados 
para los cuales fue diseñada. El hardware, 
específicamente la unidad de procesamiento 
central (CPU), memoria de acceso aleatorio 
(RAM), procesador gráfico (GPU) y unidad 
de almacenamiento, entre otros dispositivos, 
poseen características específicas para el 
cómputo de alto rendimiento. Las estaciones 
de trabajo pueden configurarse con más de 
una CPU, varias GPU y mayores cantidades 
de RAM, por lo que pueden manejar modelos 
más grandes con mayor rapidez. También 
son físicamente robustas, por lo que duran 
más tiempo en servicio que las computadoras 
personales.

Computación distribuida

Cuando el tamaño del modelo 
sobrepasa las capacidades de las 
computadoras individuales, se recurre 
a la computación distribuida. En este 
caso se conectan varias computadoras 
en red para compartir los cálculos y el 
almacenamiento de los datos. La distribución 

de la información y la integración de los 
resultados ocurre generalmente en una 
computadora específica designada para tales 
fines, normalmente conectada al menos a un 
monitor. Para coordinar la comunicación 
entre las computadoras se utiliza software 
auxiliar, comúnmente basado en el protocolo 
Message Passing Interface (MPI) y del cual 
existen múltiples implementaciones, como 
MPICH, Open MPI y Microsoft MPI. En la 
figura 1.9 se muestra un esquema de la 
clasificación del hardware mencionado.

 1.3	  Condiciones de contorno para mo-	
	  delos de huesos

Las condiciones de contorno empleadas 
en modelos mecánicos de huesos para análisis 
estáticos o cuasi estáticos son de dos tipos: 
cargas y desplazamientos. En esta sección se 
exponen las particularidades relacionadas con 
el modelado de huesos.

1.3.1	  Fuerzas
Las fuerzas fisiológicas sobre los 

huesos son producidas por la tracción de los 
músculos y la interacción con otros huesos en 
las articulaciones [3], [17], [18]. El modelado 
de estas cargas no es trivial porque al igual que 
los huesos, las características de los músculos 
y las articulaciones también varían entre 
sujetos, y la forma y localización de los puntos 
de aplicación es irregular.

El conjunto de datos del muscle 
standardized femur [19], además de proveer un 
modelo geométrico, presenta las superficies 
de inserción muscular resaltadas con colores, 
de modo que la fuerza de cada músculo se 
distribuye en el área correspondiente, como se 
aprecia en la figura 1.10. La magnitud y dirección 
de las fuerzas deben ser determinadas por el 
investigador; los trabajos de Duda [20], Polgár 
[15] y Shrivas [16] pueden servir como guía 
para la determinación de las características de 
las fuerzas.

Figura 1.9. Tipos de hardware para ejecutar software de simulación.
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Si la investigación requiere que las 
cargas sean determinadas de forma precisa, 
se puede emplear un enfoque numérico 
experimental, como el de Valente et al. [21], 
quienes usaron nmsBuilder [22] y OpenSim 
[23] para determinar los ángulos, fuerzas 
y momentos en las articulaciones, y las 
direcciones y magnitudes de las fuerzas 
musculares que actúan sobre el miembro 
inferior durante la marcha humana. En 
estudios dinámicos también se incluyen las 
cargas inerciales y condiciones iniciales de 
velocidad y aceleración [24].

Las cargas no fisiológicas pueden ser 
originadas por el impacto con objetos externos 
al organismo como resultado de actividades 
deportivas o accidentes; por ejemplo, caídas 
y choques [25]. También se consideran cargas 

Figura 1.10. Vistas del modelo estandarizado de fémur con 
las zonas de inserción muscular.

Imagen compuesta a partir del conjunto de datos en [19].

no fisiológicas las causadas por las prótesis, 
las órtesis y los productos ortopédicos para 
facilitar la movilidad [17].

1.3.2	  Desplazamientos
Los desplazamientos aplicados como 

condiciones de contorno en un análisis estático 
pueden tener dos propósitos: restringir 
desplazamientos de cuerpo rígido o forzar 
desplazamientos de cuerpo deformable en el 
hueso debido a la situación de carga actual. El 
primer tipo de uso es prácticamente obligatorio 
porque, aunque se modelen cuidadosamente 
las fuerzas aplicadas en un hueso completo, el 
equilibrio estático perfecto 
es prácticamente imposible, de forma que 
es necesario restringir algunos puntos del 
modelo para garantizarlo. La aplicación de 

desplazamientos distintos de cero es opcional 
y dependerá del objetivo de la simulación.

También se restringen los 
desplazamientos de cuerpo rígido cuando 
se modela solo una parte del hueso, como 
se muestra en la  figura 1.11. Ese modelo se 
desarrolló determinando en primer lugar 
una malla óptima para simulación, realizando 
un análisis de convergencia de malla con 
un sistema de cargas simplificadas, y luego 
se seleccionaron manualmente los nodos 
de las regiones de inserciones musculares; 
posteriormente, la fuerza de cada músculo 
se distribuyó entre los nodos seleccionados 
especificando las componentes en los tres ejes 
cartesianos. En la parte distal se fijaron en cero 
los desplazamientos de los nodos para impedir 
los desplazamientos de cuerpo rígido. No es 

Figura 1.11. Modelo de elementos finitos de la porción proximal de 
un fémur con condiciones de borde aplicadas en los nodos.

En rojo, apoyo fijo; en azul, fuerza de contacto del acetábulo del hue-
so pélvico y fuerzas de los glúteos menor, medio y mayor, piriforme, 
psoas y aductores mayor y menor.
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la forma óptima de modelar una porción de 
hueso porque no toma en cuenta la flexibilidad 
del resto del órgano, pero es la forma más 
fácil de construir el modelo. Idealmente, se 
debería modelar el hueso completo con una 
malla relativamente gruesa y luego efectuar 
un sub modelado de la porción de interés con 
una malla fina. Un enfoque alternativo sería 
restringir los desplazamientos de los nodos 
del extremo distal con resortes en lugar de fijar 
el desplazamiento en cero, pero se deberían 
determinar los coeficientes de rigidez de 
los resortes de forma que representen la 
flexibilidad del resto del hueso.

 1.4	  Biomecánica del hueso
Los huesos son órganos formados por 

tejido biológico, por lo que sus características 

Figura 1.12. Ejemplos de cada tipo de hueso según su forma.

Imagen modificada de BruceBlaus1

Imagen modificada de [26].

Figura 1.13. Partes del fémur proximal y detalles de las estructuras 
de los tejidos trabecular y cortical.

cambian con el tiempo. Las funciones básicas 
de los huesos son: soporte, locomoción, 
protección de órganos y almacenaje de 
componentes químicos; adicionalmente, 
algunos huesos tienen funciones específicas 
como la formación de células sanguíneas y la 
transmisión del sonido.

1.4.1	  Composición y estructura
Los huesos del esqueleto humano se 

presentan en formas y tamaños variados, como 
se observa en la figura 1.12. 

Dependiendo de su función, algunos 
huesos están compuestos casi totalmente 
de tejido trabecular con una capa muy fina 
de tejido cortical; en otros, el tejido cortical 
representa un porcentaje importante 
del volumen del hueso. En particular, los 

huesos largos tienen una estructura común 
consistente en una corteza externa de tejido 
cortical delgada hacia los extremos (epífisis) y 
gruesa hacia la parte media (diáfisis), y tejido 
trabecular que forma la mayoría del volumen 
de las epífisis y prácticamente desaparece en 
la diáfisis. Adicionalmente, existe una cavidad 
en la diáfisis que se encuentra ocupada con 
médula. Las trabéculas, que dan nombre al 
tejido trabecular, son tabiques que forman un 
entramado rígido y liviano. En la figura 1.13 se 
representa la estructura de la porción proximal 
del fémur con detalles de la composición de 
los tejidos cortical y trabecular. Los espacios 
aparentemente vacíos del tejido trabecular en 
realidad están ocupados con sustancias como 
grasa y médula, entre otras.

1 BruceBlaus, CC BY 3.0, https://creativecommons.org/licenses/by/3.0, via Wikimedia Commons.
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El hueso trabecular y el cortical 
tienen la misma composición química, 
diferenciándose únicamente en su densidad 
aparente, la cual se define como la cantidad 
de masa ósea por unidad de volumen y es 
una medida de la porosidad del componente 
sólido. Este componente consiste en una 
matriz inorgánica que forma más del 90 
% en volumen del tejido óseo, constituido 
en su mayor parte por fosfato de calcio 
en forma de cristales de hidroxiapatita, 
otorgándole su rigidez y resistencia, y por 
elementos orgánicos como el colágeno, los 
proteoglicanos y las proteínas no colágenas, 
entre otros, contribuyendo a su flexibilidad.

Desde el punto de vista macroscópico, 
el hueso se caracteriza por ser un material 
heterogéneo, poroso y anisótropo. La causa 
de la anisotropía depende de la orientación 
de las microestructuras de cada tipo de tejido, 
debiéndose en el hueso compacto a las osteonas 
y en el hueso esponjoso a las trabéculas, 
mostradas en la figura 1.13. Determinar 
la orientación de los ejes materiales de la 
anisotropía no es una actividad trivial, ya que 
varía en cada punto del volumen del hueso. En 
[3] se detalla un procedimiento basado en la 
variación de las direcciones de los esfuerzos 
principales durante la marcha humana. 

1.4.2	  Comportamiento mecánico del teji-	
	  do óseo

El tejido óseo es un elemento con un 
comportamiento mecánico complejo debido 
a su carácter de material orgánico, compuesto 
y heterogéneo. La heterogeneidad de su 
densidad aparente, asociada a la porosidad 
del tejido, influencia directamente sus 
propiedades elásticas y de resistencia. Por lo 
tanto, el hueso cortical es mucho más rígido 

y resistente que el hueso trabecular, como se 
observa en la figura 1.14a.

Por ser anisótropo, las propiedades 
elásticas y de resistencia varían en las diferentes 
direcciones materiales (longitudinal, tangencial, 
radial) y, además, la resistencia a la compresión 
es mayor que a la tracción, ver figura 1.14b y 
figura 1.14c. La curva esfuerzo-deformación es 
no lineal por la naturaleza viscoelástica de sus 
componentes orgánicos y, por lo tanto, la rigidez 
y la resistencia también dependen de la tasa de 
deformación causada por las cargas aplicadas, 
como se muestra en la figura 1.14d. Finalmente, 
su comportamiento mecánico varía para cada 

Figura 1.14. Comportamiento mecánico del tejido óseo en función de 
diferentes factores.

Variación de la curva esfuerzo-deformación, (a) con la densidad apa-
rente ρ, (b) con la dirección de la carga, y (d) con la tasa de deforma-
ción ε̇. Imagen (c), comparación de los esfuerzos últimos en función 
del modo de carga y del tipo de tejido óseo.

individuo dependiendo, entre otros factores, de 
la edad, sexo, raza, metabolismo, historia clínica 
y actividad física.

Existen muchas investigaciones 
experimentales para caracterizar el 
comportamiento mecánico del tejido óseo, 
obteniéndose correlaciones entre la densidad 
aparente y las propiedades de elasticidad, 
algunas de las cuales se muestran en la tabla 1.1.

Es fundamental verificar que la 
información experimental que se adquiera 
en la bibliografía y la simulación que se 
pretenda realizar sean consistentes. Uno de 
los aspectos por considerar es que la densidad 
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Tabla 1.1. Ecuaciones empíricas del módulo de elasticidad principal del tejido óseo en función 
de la densidad aparente

T: tejido trabecular; C: tejido cortical; ρ: densidad aparente húmeda; E: módulo de elasticidad 
longitudinal. Las densidades ρmin y ρmáx definen el rango válido en cada caso.

del tejido óseo puede ser expresada como 
densidad aparente húmeda (ρwet), densidad 
aparente seca (ρdry) o densidad de ceniza 
(ρash), y este factor depende de la metodología 
experimental. Otras variables son: el sexo y 
la edad de los donantes, el hueso usado para 
experimentar (fémur, tibia, vértebra, etc.), el 
lugar dentro del hueso (epífisis, diáfisis), el tipo 
de tejido (trabecular o cortical), la dirección 
de aplicación de las cargas (longitudinal, 
tangencial, radial), la tasa de deformación 
aplicada en los ensayos mecánicos (baja, media, 
alta), el estado del hueso, sano o con alguna 
enfermedad (osteoporosis, osteoartritis, etc.), 

Tabla 1.2 Ecuaciones empíricas de la resistencia principal del tejido óseo en función de 
la densidad aparente.

Sco: resistencia a la compresión (MPa); Str: resistencia a la tracción (MPa); ρ: densidad 
aparente húmeda.

y la especie (humana, otros animales). En este 
aspecto, el trabajo de Helgason et al. [34] es un 
buen punto de partida, ya que compara una 
gran cantidad de investigaciones normalizando 
las relaciones E vs. ρ publicadas a lo largo 
de los años, tomando en cuenta varios de los 
factores mencionados. Sus gráficos también 
permiten apreciar la amplia variabilidad de los 
datos obtenidos experimentalmente; por esta 
razón, al seleccionar alguna relación específica 
de este trabajo o de la tabla 1.1 para realizar 
simulaciones, los resultados que se obtengan 
serán solo indicadores del comportamiento 
mecánico real del hueso.

Si el objetivo de la simulación involucra 
determinar la posibilidad de fractura del hueso, 
los trabajos de Carter y Hayes [27], Keller [29], 
Lotz et al. [28], [31], Keyak [35], y Wirtz et al. 
[36] son fuentes relevantes de información. 
En la tabla 1.2 se muestra un resumen de 
propiedades de resistencias básicas que 
pueden usarse con criterios de falla como el de 
von Mises o el de Mohr modificado. Se puede 
observar que la resistencia a la compresión 
también depende de la densidad aparente y es 
mayor que la resistencia a la tracción.
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Figura 2.1. Diagrama de flujo general para obtener una malla de elementos 
finitos a partir de imágenes médicas para un modelo de hueso in vivo.

las resonancias magnéticas son las más usadas 
porque cumplen con estos requisitos, además 
de su accesibilidad económica y técnica.

La tomografía computarizada es el 
método preferido para obtener imágenes de 
huesos, ya que están compuestos por los tejidos 
más densos de los organismos vertebrados 
y producen imágenes con contrastes altos. 
Los principios físicos mediante los cuales se 
adquieren los datos y se reconstruye la imagen 
están descritos detalladamente en el artículo 
de Jung ([38], acceso abierto). El resultado de 
realizar una TC es una secuencia de imágenes 
digitales en escala de grises, similares a 

2.	 FASES DEL PROCESO 
PARA LA  SIMULACIÓN 
NUMÉRICA DE HUESOS

La creación de un modelo de elementos 
finitos de un hueso sigue un proceso que varía 
en función de la física que se desee simular, 
particularmente en los aspectos del material 
y de las condiciones de borde. No obstante, 
todas las simulaciones requieren un modelo 
geométrico del hueso.

 2.1	  Creación de la malla de EF a partir 	
	  de imágenes médicas

Como se expuso en la sección 1.1.3, 
propuestas como las de Viceconti et al. [19] 
proveen modelos geométricos de computadora 
que requieren una intervención mínima 
por parte del investigador.  Sin embargo, la 
creación de un modelo de hueso personalizado 
de un sujeto vivo requiere una serie de pasos 
que implica la adquisición y el procesamiento 
de imágenes médicas para obtener la malla; en 
la figura 2.1 se detalla este proceso.

2.1.1	  Adquisición de las imágenes médicas
Entre los medios disponibles para 

adquirir imágenes médicas se encuentran la 
ecografía, la radiografía (RX), la tomografía 
computarizada (TC), la tomografía por 
emisión de positrones (PET), la resonancia 
magnética (RM) y la termografía médica. Los 
profesionales de la medicina seleccionan una 
u otra opción dependiendo de las necesidades 
de diagnóstico. Desde el punto de vista de 
la simulación de seres vivos, interesan los 
medios que sean menos invasivos y permitan 
construir modelos digitales tridimensionales 
con una precisión geométrica aceptable. En 
este sentido, las tomografías computarizadas y 

radiografías analógicas. Cada valor de gris está 
directamente relacionado con la atenuación de 
los rayos X al atravesar los tejidos con distintas 
densidades. De esta manera, las imágenes 
tomográficas no solo sirven para determinar la 
morfología de los órganos, sino también para 
estimar sus propiedades físicas.

La atenuación de los rayos X se mide en 
unidades Hounsfield (HU), las cuales se definen 
de forma que los valores del agua y del aire 
son 0 y  -1000, respectivamente. En la tabla 2.1 
se muestran valores para algunas sustancias 
orgánicas de interés que son calculados tomando 
la atenuación del agua como referencia.

2.   FASES DEL PROCESO PARA LA SIMULACIÓN NUMÉRICA DE HUESOS
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Adaptado de [39].

Tabla 2.1. Valores de referencia en unidades Hounsfield de algunas sustancias 
orgánicas.

Las imágenes tomográficas consisten 
en matrices cuadradas de píxeles¹ cuyo tamaño 
dependerá de la cantidad de proyectores y de 
sensores de rayos X. El tamaño estándar es de 
512  512 píxeles y puede llegar hasta 2048 

 2048 píxeles en TC de ultra alta resolución 
[38]. La resolución se calcula dividiendo el 
tamaño físico, usualmente en milímetros, 
entre el tamaño en píxeles. Así, una imagen 
con dimensiones 247  247 milímetros y 512  
512 píxeles, tiene una resolución aproximada 
de 0,4824  0,4824 mm/pixel.

Las imágenes se producen en intervalos 
usualmente fijos, pero que también pueden 
variar por sectores. Esta separación se 
interpreta como un “espesor” de la imagen, por 
lo que cada pixel tendrá un volumen asociado 

denominado vóxel, mostrado en la figura 2.2. 
Siguiendo el ejemplo previo, si las imágenes se 
adquieren con una separación de 1 milímetro, 
cada vóxel tendrá dimensiones de 0,4824  
0,4824  1 milímetros.

Para lograr una determinación 
confiable de las densidades del tejido óseo, 
se debería incluir un patrón de calibración, 
o calibration phantom, durante la realización 
de la tomografía. Un patrón de calibración 
es un objeto transparente a los rayos X 
que tiene varias inserciones de sustancias 
con densidades conocidas, y que se utiliza 
para verificar si los valores de unidades 
Hounsfield que se reportan en la tomografía 
corresponden a las densidades esperadas. 
Con este patrón se construye la curva de 
calibración del tomógrafo, que idealmente 
debería ser una recta. En el artículo de 
acceso abierto de Le y Molloi [40] se detallan 
varios tipos de patrones de calibración, se 
muestran sus imágenes radiológicas y las 
curvas de calibración respectivas. En la 
figura 2.3 se muestra la reconstrucción 3D 
de una tomografía de un segmento del tronco 
humano en la que se observa claramente, en 
la parte inferior, la imagen radiológica de un 
patrón de calibración.

Figura 2.2. Representación de píxeles y vóxeles en 
imágenes digitales volumétricas.

Figura 2.3. Imagen tomográfica de un segmento del 
tronco humano y un patrón de calibración.

En la parte inferior se observa el patrón con 
cinco zonas circulares de densidad conocida para 
determinar la curva de calibración del tomógrafo. 
Imagen de MindwaysCT Software2.

2.1.2	  Almacenamiento de las imágenes 	
	  médicas

Las imágenes médicas se almacenan 
en un formato especificado por el estándar 
DICOM3 (Digital Imaging and Communications 
in Medicine, ISO 12052). El archivo bajo este 
formato se divide en dos partes: la primera 
es el encabezado, que contiene decenas de 
campos con información sobre la imagen, el 
equipo empleado para adquirirla, el paciente, 
el tipo de estudio, fechas y lugares, entre 
otros muchos datos. La segunda parte es la 
imagen propiamente dicha, en formatos JPEG 
comprimido o no, LZW o RLE. En general, la 
secuencia de imágenes se almacena en un 
directorio con un archivo por imagen. Más 
recientemente, el formato NRRD4 (Nearly Raw 
Raster Data), diseñado para guardar datos 

1 Un pixel es el elemento más pequeño de una imagen digital. 
2 MindwaysCT Software, CC BY-SA 3.0 <https://creativecommons.org/licenses/by-sa/3.0>, via Wikimedia Commons. 
3  https://www.dicomstandard.org.   4 https://teem.sourceforge.net/nrrd/. 
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Figura 2.4. Imagen tomográfica representada con distintas configuracio-
nes de visualización.

n-dimensionales, se ha vuelto popular como 
formato alternativo para aplicaciones médicas 
debido a que se puede almacenar toda la 
secuencia de imágenes en un solo archivo. Este 
formato también especifica un encabezado, 
pero contiene información únicamente sobre 
la composición y estructura de los datos. 
La información médica se elimina, lo que 
efectivamente anonimiza el estudio.

Al observar las imágenes en formato 
DICOM, es común que se manipule el contraste 
y el brillo del visor dependiendo del tipo de 
estructura orgánica que se desea analizar. 
El rango de las unidades Hounsfield que se 
representan en pantalla se conoce como ancho 
de la ventana (window width) y el centro de ese 
rango se conoce como centro o nivel de la ventana 

(window center o window level). El window width 
controla el contraste, mientras que el window 
center controla el brillo.

Se debe tener en cuenta que el ancho y 
centro de la ventana del visor de imágenes que 
se esté utilizando es independiente de los valores 
UH de los píxeles de la imagen que se quiera 
mostrar. Por ejemplo, si se establece un window 
center de 100 UH y un window width de 1000 UH, 
el valor máximo del rango por mostrar es 600 
UH y el mínimo es -400 UH. Los píxeles de una 
imagen tomográfica con UH ≥ 600 se mostrarán 
en blanco, y los que tengan UH ≤ -400 en negro.

El elemento izquierdo de la figura 
2.4 muestra una imagen tomográfica con la 
configuración por defecto del visor, en la que se 
pueden apreciar los tejidos musculares y óseos, 

entre otros elementos; sin embargo, se ve oscura. 
En la imagen central se observan los mismos 
tejidos, pero con mayor brillo. En la imagen de 
la derecha se redujo el rango manteniendo el 
centro original, lo que permite concentrarse en 
las estructuras óseas de la imagen.

2.1.3	  Segmentación de las imágenes médicas
La segmentación es el proceso mediante 

el cual se definen las regiones de interés en las 
imágenes. No todas las estructuras orgánicas 
que se muestran en las imágenes son de 
utilidad para el investigador. En las imágenes 
de la figura 2.4, por ejemplo, se observa a la 
derecha parte de los huesos de una pelvis, 
mientras que en el centro y a la izquierda se 
reconocen partes de la cabeza y del trocánter 

Figura 2.5. Segmentación del tálamo y sus núcleos.

(a) plano axial, (b) plano coronal, (c) plano sagital, (d) visualización 3D. 
Imagen de [41].
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mayor del fémur. Manipulando el contraste y 
el brillo de la imagen podrían apreciarse los 
tendones y los músculos. Dependiendo de los 
objetivos de la investigación, se seleccionan los 
elementos orgánicos pertinentes.

Para diferenciar unas estructuras de 
otras, la segmentación se realiza aplicando 
máscaras gráficas con colores distintivos. 
En la figura 2.5 partes a, b y c, se visualiza la 
segmentación de los seis grupos de núcleos que 
componen el tálamo en los tres planos anatómicos 
a partir de imágenes de RM multimodal ([41], 
acceso abierto) y en la que se pueden apreciar 
los colores diferenciadores. 

La segmentación se efectúa en todas las 
imágenes en las que aparecen las estructuras 
de interés, para que al integrarlas se obtenga 
un objeto tridimensional, como se observa en 
la figura 2.5d. Los programas utilizados para 
segmentar proveen herramientas manuales, 
semiautomáticas y automáticas para facilitar el 
trabajo, que suele ser laborioso. La intervención 
humana es la principal fuente de errores y de 
consumo de tiempo, por lo que la tendencia 
actual es a involucrar la inteligencia artificial (IA) 
para automatizar el proceso. Dos ejemplos de IA 

aplicada al procesamiento de imágenes médicas 
son DeepInfer1  y el proyecto MONAI2.

2.1.4	  Superficies teseladas
Todos los programas con la función de 

segmentación son capaces de producir superficies 
teseladas que describen las geometrías 
tridimensionales de las estructuras segmentadas. 
Estas superficies están conformadas por 
triángulos planos, y se almacenan en el formato 
STL desarrollado por la compañía 3D Systems® 
para aplicaciones de manufactura aditiva. Por 
ser planos, para describir sólidos curvos de 
forma “suave” se requiere una gran cantidad de 
triángulos. En la figura 2.6 se aprecia la diferencia 
en la suavidad3 de la representación de una 
esfera, entre una superficie con 72 triángulos y 
una con 192 triángulos. 

2.1.5	  Mallas de elementos finitos
Las superficies teseladas no sirven 

directamente como mallas de elementos finitos, 
ya que su creación no toma en cuenta la física que 
se desea modelar ni se cuidan los parámetros de 
calidad deseables en una simulación, como el 
sesgo (skewness) y la relación de aspecto (aspect 

Esfera izquierda, 72 triángulos; esfera derecha, 192 triángulos.

Figura 2.6. Representaciones de una esfera con superficies teseladas.

ratio). Adicionalmente, las superficies teseladas 
pueden tener cientos de miles de triángulos, 
dependiendo de la complejidad y el tamaño del 
modelo geométrico, y debe reducirse para tener 
una cantidad de elementos manejables en una 
simulación.

Una malla superficial de EF creada a 
partir de una superficie teselada es siempre 
de triángulos planos (lineales). Aunque en 
un proceso posterior se pueden convertir en 
triángulos cuadráticos, realmente no se está 
agregando información extra porque los nodos 
intermedios no siguen la curvatura inicial de 
las superficies del hueso. En consecuencia, es 
preferible mantener esta malla con triángulos 
lineales para ahorrar memoria computacional. 

Programas comerciales como 
Simpleware y Geomagic Freeform® pueden 
generar superficies NURBS4 directamente 
a partir de la segmentación, en lugar de las 
superficies teseladas. Esta función es deseable 
porque permite la creación de elementos 
finitos de orden superior que se adaptan 
mejor a las superficies curvas de los huesos. 
En la figura 2.7 se muestra que los elementos 
finitos cuadráticos y cúbicos tienen aristas que 
pueden adaptarse a las curvas orgánicas.

Figura 2.7. Tipos de elementos finitos bidimensionales.

Imagen modificada de Christophe Dang Ngoc Chan5 .

1 http://www.deepinfer.org/.   2 https://github.com/Project-MONAI/MONAI.   3 La “suavidad” se refiere a los ángulos entre 
los triángulos adyacentes que conforman una superficie. Mientras menores son los ángulos en general, mayor es la suavidad 
de la superficie.   4non-uniform rational β-splines.   5Christophe Dang Ngoc Chan, CC BY-SA 3.0, https://creativecommons.
org/licenses/by-sa/3.0, via Wikimedia Commons.
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Figura 2.8. Tipos de elementos finitos comunes para mallas tridimensionales.Después de obtener las superficies 
geométricas se puede construir un volumen 
geométrico, o pasar directamente a crear 
las mallas superficiales y volumétricas, 
en ese orden. Una malla volumétrica no 
estructurada, compuesta por tetraedros, se 
produce a partir de una malla superficial 
de triángulos. Una malla superficial de 
cuadriláteros puede dar origen a una malla 
estructurada, compuesta exclusivamente 
de hexaedros, solamente en dominios que 
tengan al menos dos pares de fronteras 
paralelas, como bloques rectangulares 
y cilindros huecos. Si no se cumple esta 
condición, además de los hexaedros se deben 
incluir elementos tipo cuña y tipo pirámide 
para las zonas de transición de la malla. 
En la figura 2.8 se muestran los elementos 
tridimensionales usados con más frecuencia 
en mallas tridimensionales. 

En la figura 2.9 se muestran las 
diferencias entre una malla tetraédrica y una 
hexaédrica del mismo volumen esférico, en 
ambos casos con elementos cuadráticos para 
que se adapten mejor a la superficie curva. 
La malla de tetraedros es estrictamente 
homogénea en el tipo de elementos, mientras 
que la de hexaedros incluye un porcentaje 
de elementos de transición. Ambas tienen 
ventajas y desventajas; la de tetraedros es 
fácil de generar independientemente de lo 
intrincada que pueda ser la geometría, pero en 
general se requieren más elementos y nodos 
para mallar el volumen. La malla de hexaedros 
utiliza menos elementos, pero es más difícil 
de generar en superficies irregulares; incluso 
hay dominios que no se pueden mallar con 
hexaedros, a menos que se construya una 
malla híbrida con tetraedros.

Figura 2.9. Vista interna de una malla tetraédrica y otra hexaédrica con elementos de transición en un 
volumen esférico.

 2.2	  Modelamiento de los materiales y            	
	  asignación de las propiedades

El modelamiento de los materiales 
que conforman el tejido óseo está definido 
por el objetivo de la simulación. Estudiándolo 
desde el punto de vista macroscópico, el 
hueso se puede considerar como un sólido 
continuo y los modelos constitutivos de 
materiales aplicables son los mostrados en 
la figura 1.5, pero también se tiene la opción 
de estudiarlo como un sistema multiescala, lo 
que agrega complejidad a la simulación. Entre 
las consideraciones principales por realizar se 
encuentran la uniformidad de las propiedades, 

el comportamiento mecánico, la anisotropía, y el 
modelo constitutivo.

2.2.1	 Uniformidad de las propiedades    	
	  mecánicas

Como se expuso en la sección 1.4, 
el tejido óseo es heterogéneo. No obstante, 
es frecuente la práctica de crear modelos 
simplificados porque consumen menos recursos 
durante el desarrollo y la simulación, siempre 
que el objetivo de la investigación lo admita. 
Los modelos simplificados más comunes son los 
totalmente homogéneos y los homogéneos por 
regiones.
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En la actualidad, los modelos 
totalmente homogéneos son poco frecuentes 
en investigación debido a que todos los 
componentes orgánicos tienen asignadas 
las mismas propiedades elásticas y su 
respuesta mecánica a las cargas podría variar 
significativamente de la realidad. Por ejemplo, 
en el trabajo de Bahia et al. [42] reportan 
una diferencia de solo el 2 % en los esfuerzos 
principales entre un modelo homogéneo y otro 
heterogéneo, pero con diferencias entre el 12 
% y el 21 % en las deformaciones principales. 
Sin embargo, precisamente por la diferencia 
pequeña en los esfuerzos principales es que aún 
se siguen desarrollando, como en el trabajo de 
Dhanopia y Bhargava [43], quienes se enfocan 
en demostrar la superioridad de una placa de 
PMMA (polimetilmetacrilato) para la reducción 
de fracturas en el fémur sobre otros materiales 
biocompatibles comparando los esfuerzos 
causados en la superficie del hueso.

Existen varias maneras de construir 
un modelo homogéneo con desplazamientos 
más parecidos a los fisiológicos. Una opción 
es segmentar solamente la capa externa 
del hueso creando un sólido hueco con una 
pared relativamente delgada en la epífisis y 
más gruesa en la diáfisis, según corresponda 
al espesor del hueso cortical y a la ubicación 
del canal medular. A la malla generada 
de esta manera se le asigna propiedades 
homogéneas de tejido cortical, desestimando 
los aportes del tejido trabecular a la rigidez 
y resistencia del hueso. Se puede mejorar 
el resultado del procedimiento previo si se 
segmenta adicionalmente el tejido trabecular, 
excluyendo el canal medular; en la figura 2.10 
se representa en forma conceptual el resultado 
de este procedimiento.

De esta forma, se obtienen dos mallas 
distintas con una parte de sus superficies en 
contacto, pero esto no implica que se pueda 
modelar directamente la continuidad que 
existe en la realidad. Existen dos opciones para 
lograrlo; la primera es asegurar que las mallas 
sean conformes, es decir, que todos los nodos 
en las superficies en contacto sean coincidentes 
para que tengan los mismos desplazamientos 
durante la solución del modelo. La segunda es, 
para mallas no conformes, modelar un contacto 
de unión sin penetración, deslizamiento o 

Figura 2.10. Segmentación de un hueso en dos 
regiones para diferenciar los tipos de tejido.

Figura 2.11. Conformidad de mallas de elementos finitos.

Izquierda1 , tres dominios 2D con mallas conformes en las fronteras Γ1 

y Γ2. Derecha, dos dominios 3D con mallas no conformes; se resaltan los 
nodos de la malla hexaédrica en los que se observa que no hay coinci-
dencia con los nodos de la malla tetraédrica.

separación. En el programa FEBio Studio se 
puede modelar este contacto como tipo Tie, y 
en Ansys se puede modelar como tipo Bonded 
(ver sección 2.4 para una descripción de los 
programas). En la imagen izquierda de la figura 
2.11 se muestran tres mallas 2D conformes, 
obsérvese cómo los nodos de las mallas 
interna y externa coinciden exactamente 
con los nodos de la malla intermedia en las 
fronteras compartidas. En la imagen derecha 
de la misma figura se muestran dos mallas 
3D no conformes, en las que los nodos no 
coinciden en la frontera común.

  1 I, Zureks, CC BY-SA 3.0 <http://creativecommons.org/licenses/by-sa/3.0/>, via Wikimedia Commons
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Definidas las dos mallas y su contacto, 
se le asigna a cada una las propiedades 
homogéneas que corresponden a los 
tejidos trabecular y cortical. Este modelo es 
homogéneo por regiones y es utilizado 
frecuentemente cuando el cálculo de los 
desplazamientos no es esencial para la 
investigación, como en los trabajos de Abe et 
al. [44] y Jitprapaikulsarn et al.  [45].

Desarrollar un modelo de elementos 
finitos completamente heterogéneo, en el que 
cada elemento tenga propiedades diferentes 
al resto, es posible pero poco práctico por la 
cantidad de procesamiento computacional 
requerido solamente para construir el 
modelo. Es más práctico crear un modelo 
heterogéneo en el que las propiedades se 
calculen por subdivisiones de densidades. Por 
ejemplo, si se tiene un rango de densidades 
entre 0,6 y 2,0 g/cm3, se puede subdividir en 
35 partes iguales de 0,04 g/cm3 para así tener 
36 grupos diferentes de propiedades elásticas 
o de resistencia. Los modelos heterogéneos 
producen resultados de desplazamientos 
mucho más cercanos a la realidad, y también 
son óptimos para simular la interacción entre 
el tejido trabecular y las prótesis internas.

Este proceso requiere correlacionar la 
ubicación de los elementos de la malla con la 
tomografía para poder determinar las unidades 
Hounsfield y, en consecuencia, la densidad que 
corresponde a cada elemento finito; es necesario 
el uso de computadoras debido a la cantidad 
de datos involucrados. Si no se tiene acceso a 
programas comerciales con esta función, los 
investigadores recurren en general a programas 
de desarrollo propio para crear las asignaciones 
de propiedades, como en el caso de San Antonio et 
al. [3]. Existe, sin embargo, un programa gratuito, 
de acceso público, llamado Bonemat que realiza 

este proceso y que se describe con más detalles 
en la sección 2.4.

2.2.2	  Comportamiento mecánico
Un modelo heterogéneo construido 

para simular solamente los desplazamientos 
requiere aplicar relaciones entre la densidad 
y las constantes elásticas, como las de la 
tabla 1.1. Si se precisa pronosticar la rotura 
del hueso se necesitarán adicionalmente 
ecuaciones que involucren la resistencia, 
como las de la tabla 1.2, junto con la aplicación 
de las teorías de falla apropiadas.

Para modelar la trayectoria de la grieta 
durante la fractura o estudiar el efecto de fatiga 
por cargas cíclicas, se tendrán que incorporar 
fundamentos teóricos más avanzados, como 
modelos de daño o mecánica de medios porosos. 
El artículo de acceso abierto de Buccino et al. [46] 
es una buena referencia inicial sobre la aplicación 
de modelos de daño al tejido óseo.

2.2.3	  Anisotropía del tejido óseo
Incorporar la anisotropía en un modelo 

de tejido óseo es una decisión compleja. La 
literatura que contiene información experimental 
sobre las propiedades elásticas y de resistencia 
en diferentes direcciones materiales es escasa y, 
adicionalmente, estas direcciones varían con la 
ubicación del tejido en la geometría del hueso. 
Por ejemplo, un punto sobre la diáfisis del fémur 
puede tener sus propiedades más altas en la 
dirección longitudinal del hueso, pero un punto 
sobre el cuello del fémur tendrá sus propiedades 
más altas en la dirección del eje del cuello. Por esta 
razón, no se pueden definir direcciones generales 
para las propiedades en direcciones longitudinal, 
transversal y radial, suponiendo ortotropía. En [3] 
se presenta un método para modelar ortotropía 
orientando los ejes materiales con base en los 
esfuerzos principales que ocurren en un fémur 
sujeto a cargas fisiológicas, y en la figura 2.12 se 
ilustran los conceptos de ejes y simetría material, 
con el modelo de ortotropía orientada aplicada al 
fémur de [3].

Figura 2.12. Simetrías materiales en orden de similitud con las propieda-
des del tejido óseo.

Los vectores unitarios ei definen los ejes y planos de referencia locales 
de cada elemento. Los vectores sin subíndice indican igualdad de propie-
dades en esas direcciones, los que tienen subíndice indican propiedades 
diferentes a las de las otras direcciones.



19

2.2.4	  Modelo constitutivo
El comportamiento mecánico del 

hueso se puede modelar hasta el punto de 
falla como puramente elástico, o se puede 
incluir el componente plástico que se presenta 
cerca de la falla. La decisión puede estar 
influenciada, entre otros factores, por la 
forma de aplicación de la carga. Por ejemplo, 
para una carga monotónica posiblemente sea 
suficiente un modelo elástico simple, pero si la 
carga es cíclica podría ser necesario incluir el 
componente plástico.  

La velocidad de aplicación de la 
carga también es importante porque influye 
en la tasa de deformación del tejido. Para 
una carga cuasi estática se pueden emplear 
modelos independientes de la velocidad de 
deformación, pero para cargas de aplicación 
rápida puede ser necesario incorporar 
modelos viscosos. En el artículo de acceso 
abierto de Reisinger et al. [47] se desarrolla 
un modelo viscoelastoplástico de tejido óseo 
cuyos parámetros pueden ser determinados a 
partir de ensayos de tracción.

 2.3	  Aplicación de las condiciones de 	
	  contorno

La aplicación de las cargas y 
desplazamientos en un modelo de elementos 
finitos está condicionada por la manera en que 
se modela el objeto de estudio. En esta sección 
se definen las metodologías según sea el caso.

2.3.1	  Objetos representados mediante 	
	  entidades matemáticas

En el caso de los modelos creados 
directamente en un programa CAD, las cargas 
y los desplazamientos impuestos se pueden 
aplicar directamente sobre las superficies 
del modelo. Cuando se genera la malla de 

2.3.2	  Objetos representados mediante 	
	  entidades numéricas

En el modelo construido a partir de la 
segmentación de las imágenes tomográficas no 
existen superficies ni volúmenes, solamente 
mallas de elementos finitos. Por esta razón, 
las cargas deben aplicarse directamente sobre 
los nodos y es deber del usuario seleccionar 
los nodos y calcular las magnitudes de las 
fuerzas que se aplicarán en cada uno. Algunos 

elementos finitos, el programa se encarga de 
distribuir las condiciones de contorno entre 
los nodos superficiales que resulten de la 
discretización de la superficie. En la figura 
2.13 se muestra una fuerza aplicada sobre una 
superficie semiesférica. Si, por ejemplo, sobre 
esta superficie se aplica una fuerza uniforme 
con resultante de 1000 newtons, y al mallar se 
crean 20 nodos superficiales, a cada nodo se 
le asigna una fuerza de 50 newtons. La ventaja 
de este método es que, si se cambia la malla, el 
programa recalcula y asigna automáticamente 
los nuevos valores entre los nodos resultantes 
del remallado.

Figura 2.13. Fuerza aplicada sobre una superficie 
semiesférica.

programas permiten especificar la magnitud 
total de las fuerzas y la forma en que se 
distribuyen (uniforme, lineal o no lineal) y 
calculan las magnitudes correspondientes 
para cada nodo. Si la condición de contorno 
corresponde a un desplazamiento impuesto, el 
procedimiento es similar. 

La desventaja de este método es que, 
al construir varias mallas de un mismo modelo 
como en el caso del análisis de convergencia, la 
selección de los nodos y el cálculo de las cargas 
o desplazamientos debe repetirse en cada 
ocasión debido a que cambia la distribución de 
los nodos. Es importante asegurar que en cada 
malla se seleccionen los nodos que describen 
la misma zona geométrica de aplicación de 
la carga para no sesgar los resultados de la 
simulación. Para seleccionar los nodos se 
puede aplicar uno de estos métodos:

•	 Seleccionar manualmente los 
nodos en la interfaz gráfica del 
programa estimando la geometría 
sobre la que se aplica la condición 
de contorno. Este método es el más 
impreciso, pero dependiendo del 
programa, en ocasiones es el único 
disponible.

•	 Crear explícitamente las superficies 
teseladas que corresponden a 
las zonas de aplicación de las 
condiciones de contorno. Así, 
en lugar de construir una sola 
superficie continua, se tendrá 
una superficie compuesta por 
sectores. Al generar la malla de 
elementos finitos, la frontera de 
cada superficie se podrá identificar 
y los nodos correspondientes se 
podrán seleccionar gráficamente 
con facilidad.



20

•	 En programas que disponen de 
un lenguaje de programación, 
como Ansys o Abaqus, es posible 
seleccionar los nodos por sus 
coordenadas. Por lo tanto, es 
factible definir regiones fijas en el 
espacio, con formas de ortoedros o 
de esferas, que contengan las zonas 
de aplicación de las condiciones de 
contorno y así seleccionar los nodos 
que estén dentro de esos volúmenes 
constantes. Este es el método más 
consistente para la selección de 
nodos en mallas diferentes del mismo 
modelo. En la figura 2.14 se observa 
un ejemplo de los pasos necesarios 
para la aplicación de este método 
utilizando comandos de APDL (Ansys 
Parametric Design Language).

un mismo formato, en ocasiones soportan 
versiones diferentes, por lo que en realidad 
no son interoperables. Frecuentemente, 
la elección de un programa para realizar 
algún proceso no está condicionada por sus 
capacidades o facilidad de uso, sino por la 
compatibilidad de formatos de archivos que 
puede leer o escribir. 

Los programas que se mencionan en 
esta sección no constituyen una lista exhaustiva 
de todas las posibilidades existentes; son 
solamente una guía para iniciar al lector en el 
desarrollo de los modelos personalizados de 
huesos. Al final de esta sección, en la tabla 2.2, 
se compilan las direcciones en las que se puede 
aprender más sobre cada programa y acceder a 
la descarga del código fuente o los ejecutables.

2.4.1	 Segmentación y creación de la su-	
	  perficie teselada

En esta categoría se incluyen 
programas capaces de leer imágenes DICOM 
y producir superficies teseladas a partir de 
la segmentación. No se incluyen programas 
de aplicación clínica que actúan únicamente 
como visores de imágenes.

Una recomendación al explorar 
opciones de programas para segmentar 
imágenes es que se comparen las coordenadas 
de los nodos de la superficie teselada generada 
por el programa con los datos de las imágenes 
médicas en formato DICOM, particularmente 
de los campos Image Position Patient o Slice 
Location. Normalmente, las coordenadas 
de las imágenes producidas por equipos 
médicos están asociadas a un origen del 
sistema de referencia del equipo. Al realizar 
la segmentación, la mayoría de los programas 
transfieren el sistema de referencia de las 
imágenes a la superficie teselada, por lo que 

 2.4	  Software gratuito para simulación
En la actualidad no existe un 

programa gratuito que permita desarrollar 
todo el proceso, desde el procesamiento de 
la tomografía hasta la simulación del modelo 
de elementos finitos. Por consiguiente, es 
necesario dividirlo en etapas que se ejecutarán 
en diferentes programas especializados que, 
sin embargo, pueden tener funciones que se 
solapan entre sí.

Al seleccionar los programas que se 
utilizarán en cada fase, se debe prestar especial 
atención a la interoperabilidad. Debido a que 
provienen de fuentes distintas, en general 
no se pueden “copiar y pegar” los datos 
entre programas, sino que la información se 
comparte mediante archivos. Por esta razón, 
se debe verificar que el formato de salida de 
un programa en una etapa pueda ser leído 
por el programa de la siguiente etapa. Aun 
cuando ambos programas compartan en teoría 

Figura 2.14. Aplicación de una fuerza distribuida sobre un grupo de nodos.

Pasos del proceso usando Ansys, (a) malla superficial; (b) nodos super-
ficiales; (c) nodos seleccionados utilizando coordenadas rectangulares; 
(d) carga distribuida aplicada sobre los nodos.
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la matriz volumétrica que contiene los datos 
de las imágenes y las superficies teseladas se 
encuentran superpuestas en el espacio. Esta 
condición es necesaria para poder calcular 
correctamente las propiedades mecánicas 
heterogéneas del modelo de elementos finitos. 
Algunos programas, en cambio, aplican un 
offset que modifica el sistema de referencia 
trasladando el origen (0; 0; 0) de la superficie 
teselada al vóxel con las coordenadas más 
cercanas a cero, por lo que la superficie y los 
datos de las imágenes quedan desfasados. 

3D Slicer

Es el programa más completo y versátil 
en este ámbito, de código abierto y ampliable 
a través de extensiones. Sus funcionalidades 
son extensas y, empleando los módulos y 
extensiones disponibles, se puede realizar 
desde la segmentación de las imágenes 
hasta la creación de mallas volumétricas de 
EF, incluyendo el acondicionamiento de la 
superficie teselada. Una desventaja es que la 
curva de aprendizaje es pronunciada debido 
a la gran la cantidad de opciones y porque, en 
principio, la estructura mediante la cual se 
organizan los datos de los proyectos puede 
ser confusa.

Seg3D + BioMesh3D

Seg3D es relativamente fácil de 
usar para segmentaciones manuales y 
semiautomáticas. Por sí solo no puede 
generar la superficie teselada, pero la 
segmentación puede usarse como entrada 
para el programa BioMesh3D, producido 
por el mismo laboratorio, para crear mallas 
superficiales y volumétricas. BioMesh3D no 
se puede descargar individualmente, sino 

aditiva, existe un sinnúmero de aplicaciones 
web y de escritorio que tienen en mayor o 
menor grado la capacidad de reparación de 
superficies teseladas. Sin embargo, el énfasis 
de esta sección es en programas de escritorio 
con herramientas robustas para reparar las 
superficies sin tener que afrontar una curva de 
aprendizaje pronunciada.

MeshLab

Es de código abierto, desarrollado 
específicamente para tratar con superficies 
teseladas. Se puede usar para generar las 
superficies a partir de la adquisición de nubes de 
puntos, y tiene herramientas para alinear, editar, 
transformar, reparar e imprimir las mallas, entre 
otras funciones.

MeshMixer

Desarrollado por la compañía 
Autodesk, es gratuito y de código cerrado. 
Autodesk abandonó su desarrollo desde 2021, 
pero sigue siendo un programa robusto, con 
reparación automática de superficies teseladas 
y con funciones avanzadas para modelado, 
incluyendo esculpido y combinación de mallas.

FreeCAD

Es un programa de modelado geométrico, 
de código abierto, cuyas funcionalidades se 
han extendido gradualmente con herramientas 
para ingeniería y manufactura asistidas por 
computador (CAE/CAM). Cada herramienta 
se encuentra implementada en un módulo 
(workbench), incluyendo uno para la manipulación 
de mallas y superficies teseladas que permite su 
edición y reparación manual o automática.

que se incluye con la descarga de SCIRun, una 
plataforma computacional en la que se efectúa 
la interconexión visual de módulos para la 
solución de problemas científicos. Los tres 
programas son de código abierto.

inVesalius

De código abierto, es muy sencillo de 
usar porque su interfaz integra directamente el 
flujo de trabajo, desde la lectura de las imágenes 
tomográficas hasta la exportación de la superficie 
teselada. Tiene herramientas manuales y 
semiautomáticas para la segmentación.

Stradview

Es un programa de código cerrado, 
gratis para uso académico o personal, pero que 
requiere pago de licencia para uso comercial. 
Tiene más opciones para segmentación que 
inVesalius y Seg3D, y puede generar y exportar 
la superficie teselada, pero 3DSlice tiene 
algunas herramientas más avanzadas. Cuenta 
con una función poco común para estimar el 
espesor de la capa de tejido cortical en el hueso. 
Esta información se exporta a archivos que 
pueden ser importados y usados por Bonemat 
(ver 2.4.3) para mejorar la asignación de 
propiedades heterogéneas. 

2.4.2	  Procesamiento de superficies tese-	
	  ladas

Las superficies construidas con los 
programas de segmentación no están exentas 
de errores. Entre los problemas que pueden 
surgir se encuentran vértices y teselas 
superpuestas, superficies abiertas, auto 
intersecciones y orientaciones invertidas de 
las teselas, entre otros. Se debe tener en cuenta 
que, dada la popularidad de la manufactura 
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2.4.3	  Creación de los modelos de elemen-	
	  tos finitos

La siguiente fase consiste en convertir 
la superficie teselada en una malla volumétrica 
de elementos finitos. En general, cualquier 
programa de simulación puede importar el 
archivo con la superficie teselada y producir 
una malla volumétrica. Posteriormente, se 
asignan las propiedades de materiales, se 
aplican las condiciones de contorno, y se 
resuelve el modelo.

Existe una innumerable cantidad de 
programas que emplean métodos numéricos 
para la simulación de fenómenos físicos. 
Sin embargo, debido a la particularidad del 
propósito de este texto, la selección se reduce 
a unos pocos programas. Las razones se harán 
evidentes en las descripciones de cada uno.

FEBio Studio

Es un programa multifísico de código 
abierto orientado específicamente hacia la 
simulación de estructuras orgánicas, por 
lo que, además de para sólidos elásticos, 
dispone de modelos constitutivos para 
plasticidad, hiperelasticidad, viscoelasticidad 
y viscoplasticidad. También puede simular 
fluidos monofásicos y multifásicos y problemas 
de transferencia de calor y reacciones químicas. 
El modelador geométrico es bastante limitado, 
pero no es relevante para la simulación 
de huesos debido a que la entrada será la 
superficie teselada.

FEBio Studio es en realidad una 
interfaz gráfica que integra tres módulos: 
un preprocesador, un postprocesador y el 
programa de cálculo, llamado FEBio. FEBio 
utiliza como entrada un archivo de texto en 
el que se configura todo el modelo de EF 
por resolver, incluyendo las propiedades de 

código cerrado.  Este programa puede importar 
mallas volumétricas e imágenes tomográficas 
para calcular propiedades de elasticidad 
isotrópica, y crear modelos heterogéneos que 
se pueden exportar a programas de elementos 
finitos, como Ansys y Abaqus, y también en un 
formato neutral.

Ansys Student

Ansys es una compañía de software de 
simulación comercial que produce programas y 
provee servicios para la solución de una amplia 
gama de problemas de ingeniería. Dispone de 
software de uso gratuito para estudiantes entre 
los que se encuentra Ansys Student, que es un 
paquete de programas para la simulación de 
estructuras, fluidos, electrónica y varias otras 
físicas. Al igual que FEBio Studio, en el ámbito 
estructural dispone de modelos constitutivos 
para elasticidad, plasticidad, viscoelasticidad, y 
más. Siendo un programa para uso no comercial 
tiene algunas limitaciones, entre las que se 
encuentra el número de nodos y elementos, 
por lo que solo pueden resolverse problemas 
pequeños o medianos.

En la tabla 2.2 se listan las direcciones 
URL de las páginas en las que se encuentran 
los enlaces de descarga de todos los programas 
mencionados en esta sección, así como sus 
manuales de usuario y otros enlaces de 
interés.	

los materiales. Es posible definir materiales 
de forma heterogénea manualmente o con 
ciertas funciones que pueden hacer variar 
las propiedades en función de la ubicación 
geométrica de los elementos. Sin embargo, la 
única manera de proyectar las propiedades 
del tejido óseo en la malla de elementos 
finitos es mediante un programa de desarrollo 
propio que escriba la sección de materiales del 
archivo de entrada a FEBio. Al momento de la 
publicación de este texto, la interfaz gráfica de 
FEBio Studio tampoco tiene esta funcionalidad. 
Por esta razón, solo se puede usar para asignar 
propiedades a un modelo homogéneo global o 
por regiones, como se expuso en la sección 2.2.1.  

Bonemat

Los modelos óseos heterogéneos con 
decenas de grupos de propiedades elásticas 
no son poco comunes, ya que existen tanto 
programas comerciales como de desarrollo 
propio que correlacionan de manera 
automática la ubicación de los elementos 
finitos del modelo con los vóxeles de las 
tomografías, permitiendo estimar la densidad 
aparente y, por consiguiente, las propiedades 
mecánicas en cada elemento. Para ello se 
utilizan, por ejemplo, las ecuaciones de la 
tabla 1.1 para el módulo de elasticidad. Los 
programas de desarrollo propio, descritos 
en la sección 1.2.5, tienen interfaces toscas, 
si es que disponen de ellas, ya que están 
destinados a ser utilizados por los miembros 
de los equipos de investigación. Bonemat fue 
desarrollado en el Istituto Ortopedico Rizzoli1  
inicialmente para sus investigaciones, pero 
tiene una interfaz relativamente refinada que 
permite que cualquier usuario interactúe con 
el programa. Fue publicado posteriormente 
en internet para su uso gratuito, aunque es de 

  1 https://www.ior.it/en 
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Tabla 2.2. Direcciones URL de programas gratuitos para la construcción de modelos de 
elementos finitos de huesos.
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Para que el lector pueda seguir 
el estudio de caso en su computador, las 
imágenes tomográficas, las mallas, los 
modelos de elementos finitos y otros recursos 
están disponibles en un repositorio en el 
enlace https://rebrand.ly/DataSetMNH, o 
siguiendo el código QR al pie de la página.

 3.1	  Fuente de los datos
El modelo se basa en un estudio 

tomográfico anonimizado del fémur izquierdo 
de una persona sin patologías óseas. Se dispone 
de 155 imágenes de 256⨯256 píxeles con una 
resolución de  mm/píxel en ambos ejes, 
que corresponden a los primeros 154 mm de la 
región proximal, adquiridas con una separación 
de 1 mm. Las imágenes se encuentran en el 
directorio femurCT del repositorio.

 3.2	  Segmentación de las imágenes y 		
 	  creación de las superficies teseladas

Se recomienda crear un directorio para 
el trabajo de segmentación, y dentro de este 
guardar las imágenes tomográficas en otro 
directorio; por ejemplo, femurSeg/femurCT.

Abrir Stradview, dirigirse a la 
opción de menú File → Open directory… 
y seleccionar el directorio en el que se 
encuentran las imágenes tomográficas. Si 
se muestra un aviso ofreciendo ordenar las 
imágenes (frames) por ubicación, elegir Sí. 
Para aumentar el tamaño de la ventana en la 
que se muestran las imágenes, ir a la opción 

3.	 ESTUDIO DE CASO: 
FÉMUR SUJETO A UNA 
FUERZA DE COMPRESIÓN                                                                   
 
 
	 Como ejemplo de aplicación de los con-
ceptos expuestos en los capítulos anteriores, 
en este capítulo y subsiguientes se desarrollan 
modelos de la porción proximal de un fémur 
sujetos a un caso de carga sencillo. Uno de los 
modelos se construye con propiedades homo-
géneas (capítulo 4) y el otro con propiedades 
heterogéneas (capítulo 5), y sirven como base 
para la elaboración de modelos más comple-
jos apropiados para investigación y desarro-
llo. Los programas empleados son:

•	 Segmentación y superficie teselada: 
Stradview 7.22

•	 Acondicionamiento de la superficie 
teselada: FreeCAD 0.21.1

•	 Mallado superficial/volumétrico y 
simulación del modelo homogéneo: 
FEBio Studio 2.3.0 [48]

•	 Cálculo de propiedades heterogéneas: 
Bonemat 4.0 [49]

•	 Simulación del modelo heterogéneo: 
Ansys Student 2023 R1

Las razones por las que se utiliza FEBio 
Studio para simular el modelo homogéneo y 
Ansys Student para el modelo heterogéneo 
están basadas en las características de ambos 
programas, explicadas en la sección 2.4.3: 
crear y asignar propiedades heterogéneas 
en FEBio Studio no es trivial, pero no limita 
el tamaño del modelo, y Ansys Student tiene 
restricciones en el tamaño del modelo, pero en 
asociación con Bonemat se puede simular el 
modelo heterogéneo con facilidad.  

de menú GUI → Windows for 2D. Al terminar 
estas operaciones la interfaz debe verse como 
la figura 3.1. Guarde su trabajo, File → Save, 
se creará un archivo con extensión sw en la 
carpeta de trabajo; este será el archivo que 
deberá abrir si desea continuar con el trabajo 
en otro momento.

3.   ESTUDIO DE CASO: FÉMUR SUJETO A UNA FUERZA DE COMPRESIÓN
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Figura 3.1. Interfaz de Stradview luego de cargar las imágenes tomográficas.

En el panel izquierdo hay varias 
pestañas y para segmentar la imagen se 
debe trabajar en la pestaña Draw. En la parte 
inferior de esta pestaña se encuentra una lista 
por defecto de once objetos y sus propiedades 
modificables, entre las que se incluye el 
nombre y el color. Es importante que la 
opción Cap esté marcada, ya que se producirán 
automáticamente superficies planas en los 
extremos del modelo. En caso contrario, la 
superficie teselada quedará abierta y no se 
podrá generar un sólido.

Los objetos de esta lista sirven para 
identificar distintas estructuras dentro de una 
tomografía. Por ejemplo, con las imágenes 
suministradas se podría segmentar el fémur 
como Object 0 y el hueso de la pelvis como 

interactuando con una máscara de umbral 
(threshold). Una máscara es un elemento 
gráfico superpuesto a una región de interés 
que se puede delimitar de diferentes maneras, 
como se muestra en la figura 3.2.

Object 1. Para este tutorial se dejarán las 
opciones por efecto.

Para aislar la visualización de los 
tejidos óseos de alta y baja densidad se debe 
configurar la presentación de las imágenes. 
Para ello, se selecciona la opción del menú 
Configure → DICOM display y se configuran los 
deslizadores de windowing centre en alrededor 
de 550 y el windowing width en cerca de 900.

Existen dos herramientas principales 
para crear los contornos de segmentación, un 
lápiz  y un borrador , ambos ubicados 
en la barra de herramientas situada en la 
parte superior de la ventana gráfica. La 
segmentación puede hacerse de forma 
completamente manual, usando solamente 
el lápiz y el borrador, o semiautomática, 
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Tabla 3.1. Acciones para segmentar usando las herramientas lápiz y borrador de 
Stradview.

Figura 3.2. Máscara y segmentación de tejido cortical.

Sección de fémur. Izquierda sin máscara, centro con máscara, derecha 
con máscara y contorno segmentado.

En particular, la definición mediante 
umbrales se realiza fijando los valores mínimo 
y máximo de UH dentro de los cuales existe 
la máscara. Por ejemplo, si en una imagen el 
tejido cortical se encuentra entre 700 UH y 
1200 UH, al fijar esos valores como umbrales 
la máscara se superpondrá a la imagen en 
las zonas en las que se cumpla ese rango. En 
la figura 3.2 se ilustra el uso de una máscara 
para la segmentación de tejido cortical, y en la 
tabla 3.1 se lista un resumen de cómo usar las 
herramientas lápiz y borrador para segmentar.

La configuración de la máscara no 
es un tema trivial por varias razones. Una de 
ellas es que hay zonas de los huesos, como en 
la cabeza del fémur, en las que prácticamente 
no existe tejido cortical, y definir un valor muy 
bajo de umbral para que se incluya el perímetro 
de la cabeza del fémur causará que se incluya 
la penumbra que rodea las zonas de tejido 
cortical muy denso, como en la diáfisis. Esto 
tiene como consecuencia que los contornos 
de la diáfisis abarquen un área mayor que el 
área real de la sección transversal, por lo que 
el modelo no será geométricamente correcto. 
En la figura 3.3 se muestra el efecto descrito.

Otro factor muy importante es que los 
umbrales dependen de los valores del ancho y el 
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Figura 3.3. Efecto de usar un umbral mínimo muy bajo para segmentar el 
tejido trabecular.

se encuentra seleccionado Object 0. La 
configuración de la máscara de umbral se 
encuentra en la sección Contour creation de 
la pestaña Draw. Para utilizarla, se marca la 
casilla thresholds en la etiqueta Show, con 
lo que se habilitan tres deslizadores: Grey 
(mínimo), to (máximo) y not (excluir). El 
programa normaliza el rango original de UH a 
una escala de 0 a 255 niveles de gris; el nivel 
0 corresponde al color negro, mientras que el 
255 describe al color blanco.

Un compromiso aceptable para el 
umbral mínimo es 90, mientras que el máximo 
se fija en el valor más alto, 255, y la exclusión 
en cero. La máscara no cubre toda la penumbra 
en la diáfisis, pero casi toda la cabeza del fémur 
y la mayor parte del trocánter mayor deberán 

segmentarse manualmente. Para que no se 
procese solamente la imagen actual, se debe 
fijar la opción Every ___ frames a un valor mayor 
que cero, en este caso se establece en 1. Otras 
configuraciones son: Segment regions → Body, 
Within → 300 mm, marcar Connected regions 
only, Ridges y valleys, pero desmarcar in 3D; Join 
gaps of (pixels) → 25, Fix concavities (strength) 
→ 50 y Contour accuracy → 5. Al hacer clic con 
la herramienta lápiz dentro de la máscara en 
cualquier imagen, como la 154, se segmentan 
automáticamente todas las imágenes, 
obteniéndose una representación en la ventana 
3D similar a la de la figura 3.4. Obsérvese que por 
haber desmarcado in 3D y haber seleccionado 
una parte de la máscara perteneciente al fémur, 
no se segmentó automáticamente el hueso de la 
pelvis. En caso de que ocurra, se deberán borrar 
todos los contornos correspondientes.

Como se puede advertir, la segmentación 
está incompleta en las zonas que no cubrió la 

centro de la ventana (windowing) fijados en DICOM 
display. Si se cambian inadvertidamente estos 
niveles, los umbrales producirán una máscara 
distinta y si ya se ha hecho la segmentación de 
otra parte de las imágenes, se creará un modelo 
distorsionado. Es muy fácil cambiar los valores 
inesperadamente porque al presionar el botón 
izquierdo del ratón con la herramienta mano   
seleccionada se cambia el windowing de la ventana 
gráfica 2D en lugar de desplazar la imagen, como 
podría intuirse.  

Para desplazar la imagen se debe presionar 
el botón central del ratón. Por esta razón, una vez 
configurado el windowing es conveniente anotarlo 
para restaurar los mismos valores, de ser necesario.

Al iniciar la segmentación se debe 
verificar que en la lista de Current object 

Figura 3.4. Segmentación automática inicial.
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Figura 3.6. Edición de la segmentación automática, dificultad media.

Figura 3.7. Edición de la segmentación automática, dificultad alta.

Figura 3.5. Edición de la segmentación automáti-
ca, dificultad baja.

máscara, y además existe una segmentación 
interna en las zonas del canal medular y tejido 
óseo de baja densidad, que no interesan en 
este caso. A continuación, en la ventana 2D se 
realizan los procesos de borrado, reparación y 
segmentación manual usando las acciones de la 
tabla 3.1, de los cuales se dan ejemplos en las 
figuras 3.5, 3.6 y 3.7.

Al finalizar la edición de la 
segmentación de todas las imágenes, se obtiene 
una representación 3D como la de la figura 3.8. 
Comparada con la figura 3.4, se observa que 
todos los contornos externos se encuentran 
completos y que no existen contornos internos.

El siguiente paso es generar la 
superficie teselada. La configuración para 
este procedimiento se encuentra en la sección 
Surface creation de la pestaña Draw. Las 
opciones se configuran como sigue: Resolution 
→ High, Smoothing → Low, Prioritize → marcar 
body, desmarcar holes. El resto de las opciones 
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se dejan por defecto. A continuación, se presiona 
el botón Update de la sección Current object 
de la pestaña Draw para generar la superficie 
teselada. En la ventana 3D se debe obtener un 
modelo como el de la imagen izquierda de la 
figura 3.9, con una superficie suave y continua, 
pero que muestra las irregularidades propias 
de la superficie ósea.

Para observar los triángulos que 
conforman la superficie, se presiona la tecla 
“L”. Realizando un acercamiento, como el que 
se muestra en la imagen derecha de la figura 
3.9, se puede apreciar que los triángulos son 
uniformes y pequeños en comparación con el 
tamaño del modelo, con lo que se puede confiar 
en poder obtener una malla de elementos 
finitos adecuada.

El paso final consiste en exportar la 
superficie. Para ello, se presiona el botón Save 
de la sección Current object. En la caja de diálogo 
se tienen varias opciones de formato; para este 
estudio de caso se selecciona el formato ply.

 3.3	  Discretización del volumen
El mallado del dominio, que es el 

volumen del hueso, requiere tres etapas que 
están determinadas por el software usado. Las 
etapas son: comprobación y acondicionamiento 
de la superficie teselada, creación de la malla 
superficial de elementos finitos y, finalmente, 
la construcción de la malla volumétrica. En 
esta sección se detallan los pasos necesarios 
en cada etapa.

3.3.1	  Comprobación y acondicionamiento 	
	  de la superficie teselada

La importación directa de la superficie 
teselada en FEBio Studio, usado para crear la 
malla superficial de elementos finitos, ocasiona 
problemas que impiden su manipulación. Si 
bien este programa tiene herramientas para 
reparar errores en la superficie teselada, para 
esta función es preferible usar el módulo Mesh de 
FreeCAD debido a su robustez y facilidad de uso.

Figura 3.8. Segmentación final.
Figura 3.9. Superficie teselada a partir de la segmentación.

Izquierda, representación continua de la superficie teselada. Derecha, 
triángulos que conforman la superficie teselada.
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Figura 3.10. Superficie teselada del fémur en FreeCAD.

Para iniciar la comprobación y posible 
reparación de la superficie teselada, abrir 
FreeCAD y dirigirse a la opción de menú File → 
Open… Seleccionar y abrir el archivo exportado 
de Stradview. En el cuadro de diálogo siguiente, 
seleccionar la opción Stanford Triangle Mesh 
(Mesh). Aparecerá la superficie teselada en la 
ventana gráfica, como se muestra en la imagen 
principal de la figura 3.10.

Seleccionar Mesh en la lista desplegable 
de módulos, ver inserto en la figura 3.10, y 
hacer clic en el botón Evaluate and repair 
mesh…  el cual abre la caja de diálogo que 
se presenta recortada en la figura 3.11 para 
mostrar solamente las opciones relevantes. 
Los pasos, señalados en esa misma figura, son:

1.	 Seleccionar en la lista desplegable 

de Mesh information la superficie 
teselada importada.

2.	 Hacer clic en el botón Analize de 
la última opción, ya que es la que 
realiza todas las comprobaciones 
disponibles.

3.	 Si aparece una marca de verificación 
en la opción Duplicated points, hacer 
clic en el botón Repair. No intente 
reparar aún otros posibles errores 
que puedan estar señalados. Se 
obtienen mejores resultados si 
luego de cada reparación se efectúa 
un nuevo análisis general.

4.	 Volver a hacer clic en el botón 
descrito en el paso 2. Si sigue 
habiendo algún error, entonces 

se reparan en secuencia. Si no, se 
continúa con el paso siguiente.

5.	 Hacer clic en el botón Close para 
finalizar las reparaciones.
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Finalizada la reparación, se exporta 
la superficie teselada navegando hasta la 
opción de menú File → Export… En la lista de 
formatos, seleccionar Stanford Triangle Mesh 
(*.ply). Se recomienda cambiar el nombre del 
archivo para evitar sobrescribir el original 
producido por Stradview.

3.3.2	  Creación de la malla superficial de 	
	  elementos finitos

En esta parte del procedimiento se utiliza 
FEBio Studio. Este programa tiene la limitación 
de no aceptar rutas para lectura y escritura de 
archivos que contengan espacios. Por esta razón, 
se debe tener la previsión de crear un directorio 
de trabajo con una ruta sin espacios, por ejemplo 
C:\femurFS, y almacenar allí la superficie teselada 
acondicionada con FreeCAD.

Importación de la superficie teselada

Abrir FEBio Studio y navegar a File → 
New Model… En la caja de diálogo siguiente, 
seleccionar la física Structural Mechanics 
y cambiar el nombre del modelo por uno 
descriptivo. Guardar el archivo del modelo en 
el directorio preparado previamente.

Para importar la superficie teselada, ir a 
File → Import Geometry… y seleccionar el archivo 
correspondiente. Al final de este proceso se debe 
tener el modelo en un estado similar al de la 
imagen izquierda de la figura 3.12.

Figura 3.11. Herramienta para evaluar y reparar mallas de 
FreeCAD.
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Figura 3.12. Superficie teselada en FEBio Studio.

Izquierda, superficie importada. Derecha, características obtenidas con Mesh Inspector.

Para revisar las características de la 
superficie teselada, se presiona el botón Select 
Objects  , se selecciona la superficie y luego 
el botón Mesh Inspector . Se abre una caja 
de diálogo como la mostrada en la imagen 
derecha de la figura 3.12. Allí se informa 
que la superficie está compuesta por 47 124 
triángulos de tres nodos (TRI3), con índices 
de calidad que varían entre 0,0839 y 0,865, 
y tamaños de aristas entre 0,382 y 2,04 mm. 
Aunque la información de unidades no se 
almacena en los archivos con formato ply, los 
valores de resolución, posiciones y distancias 
almacenadas en los encabezados de las 

imágenes DICOM se encuentran en milímetros, 
por lo que las dimensiones asociadas a la 
superficie se encuentran en esas unidades.

Remallado y conversión de la 		
	   superficie teselada

Uno de los pasos de las simulaciones con 
el MEF es el análisis de convergencia de la malla. 
Tradicionalmente, a partir de la geometría se 
crean mallas con tamaños de elementos que van 
variando desde grandes (pocos elementos) hasta 
pequeños (muchos elementos); sin embargo, en 
este caso no se tienen superficies y volúmenes, 
sino directamente una malla superficial. La 

conversión de la superficie teselada en una malla 
2D de elementos finitos es directa; los triángulos 
pasan a ser elementos planos. La generación 
posterior de una malla volumétrica tomará 
los elementos planos como una de las caras de 
los tetraedros y, tomando en cuenta que las 
longitudes de arista de los triángulos representan 
desde el 0,24 % hasta el 1,3 % de la dimensión 
mayor del modelo de fémur, se puede esperar 
que se obtenga una malla grande y posiblemente 
difícil de manejar. Para poder hacer un análisis 
de convergencia, se requiere reducir el número 
de triángulos sin modificar sustancialmente la 
geometría del modelo.
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Al seleccionar la superficie debe 
aparecer su nombre en el campo Name, 
señalado en la figura 3.13. La herramienta 
Decimate realiza una reducción de la cantidad 
de triángulos eliminando vértices o aristas 
mientras trata de mantener la superficie 
original. La herramienta MMG Remesh utiliza 
el software abierto Mmg1 para remallar la 
superficie teselada. En la tabla 3.2 se efectúa 
una comparación entre los dos métodos para 
poder realizar una selección fundamentada.
	 Ambos métodos, configurados con los 
parámetros especificados en la tabla 3.2 para 
producir elementos con aristas de alrededor de 
4 mm, producen una cantidad similar de trián-

gulos. El método Decimate genera aristas con 
un rango menor por lo que la variabilidad es 
más baja, lo que es deseable en una malla, y las 
aristas más grandes están más cerca de los 4 
mm esperados. Las calidades media y máxima 
de los triángulos que producen ambas opcio-
nes son similares, pero la calidad mínima del 
primero es mayor, por lo que se selecciona De-
cimate como método de reducción de triángu-
los. La figura 3.14 muestra las dos superficies, 
antes y después de la reducción, para verificar 
visualmente los cambios en la geometría.

El programa FEBio Studio ofrece 
herramientas para reducir la cantidad de 
triángulos de la superficie teselada y, en 
consecuencia, de la malla de elementos finitos. 
En una instalación por defecto, a la derecha de 
la ventana gráfica se encuentra el módulo Build, 
que tiene cuatro pestañas: Create, Edit, Mesh y 
Tools. Como su nombre lo indica, este módulo 
sirve para desarrollar los aspectos geométricos 
y de mallado. En la figura 3.13 se muestra el 
módulo Build abierto en la pestaña Edit, que tiene 
las herramientas para manipular superficies 
teseladas. En FEBio Studio, una superficie 
teselada se denomina Editable Surface, como se 
observa en el campo Type.

Figura 3.13. Pestaña Edit en el módulo Build. Tabla 3.2. Dos métodos para reducir la cantidad de triángulos de la superficie 
teselada.

 1 https://www.mmgtools.org/
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Figura 3.14. Superficies teseladas.

Izquierda, superficie original. Derecha, superficie reducida con Decimate 
en la que se señalan zonas de cambios sutiles en la geometría.

Es importante tomar en cuenta 
dos factores al realizar este proceso. En 
primer lugar, la reducción de triángulos por 
cualquiera de los dos métodos produce una 
“suavización” de la superficie que es más 
acentuada a medida que se reduce la cantidad 
de triángulos, llegando a distorsionarse 
algunas características anatómicas del hueso; 
por esta razón, se debe utilizar este recurso 

sin perder de vista la calidad del modelo. En 
la figura 3.14 se indican algunas zonas de la 
superficie reducida en las que se detectaron 
cambios sutiles en la geometría. Estos cambios 
se pueden desestimar si no se encuentran en 
zonas críticas, por ejemplo, con esfuerzos 
máximos.

En segundo lugar, si se desea 
desarrollar varios modelos reduciendo el 

número de triángulos en diferentes cantidades, 
debe hacerse cada uno a partir de la superficie 
original y nunca disminuyendo triángulos de 
una superficie ya reducida, debido a que los 
errores geométricos se multiplican de esa 
manera.

En la nomenclatura de FEBio Studio, 
una malla de elementos finitos se denomina 
Editable Mesh. La obtención de la malla 
superficial de elementos finitos se efectúa 
convirtiendo la superficie de Editable Surface a 
Editable Mesh haciendo clic en la lista Convert 
del campo Type, resaltado en la figura 3.13.

3.3.3	  Creación de la malla volumétrica
En FEBio Studio existen dos maneras de 

crear la malla volumétrica:
1.	 Directamente a partir de la 

superficie teselada, antes de 
convertirla a una malla de EF, 
cambiar a la pestaña Mesh. 
Allí se muestran solamente los 
parámetros para crear una malla 
de tetraedros usando el programa 
TetGen1 , que es un generador de 
mallas tetraédricas.

2.	 Seguir el procedimiento explicado 
al final de la sección anterior. 
Realizada la conversión, en la 
pestaña Mesh se encuentra una 
amplia lista de herramientas para 
trabajar con mallas superficiales 
y volumétricas, entre las que se 
encuentra de nuevo TetGen.

La segunda opción es la más 
recomendable porque da acceso a 
herramientas avanzadas; por ejemplo, se 
puede generar una malla híbrida con una capa 
de elementos tipo Shell sobre la superficie de 
una malla volumétrica para modelar una capa 

 1 https://www.wias-berlin.de/software/index.jsp?id=TetGen&lang=1



35

delgada de un material sobre un sólido de otro 
material. Con la primera opción también están 
disponibles algunas herramientas, pero en 
menor cantidad.

Aunque de ambas formas se accede 
a TetGen, existen parámetros configurables 
diferentes en cada una. Por las ventajas 
mencionadas, se utilizará el segundo método. 
Luego de convertir la superficie a una malla y 
seleccionar el botón TetGen, se tiene acceso a 
los siguientes parámetros de configuración:

•	  Minimum radius-edge ratio 
(MRER): es la relación entre el radio 
de la esfera en la que está inscrita 
el tetraedro y la longitud de su 
arista más corta, y su valor mínimo 
teórico es aproximadamente 0,621 
[50]. Sin embargo, el algoritmo 
falla frecuentemente si se le pide 
valores menores a 1. El valor por 
defecto es 2, que se considera 
una calidad buena; un valor de 
1 o 1,1 producirá tetraedros de 
mejor calidad, pero a expensas 
de incrementar sensiblemente su 
número.

•	 Element size: es el valor deseado 
para la longitud de la mayor arista 
de los tetraedros.

•	 Split facets: si se marca se permitirá 
a TetGen dividir un triángulo 
superficial en dos.

•	 Feather: regula la cantidad de capas 
de transición entre un volumen que 
se está remallando y un volumen 
adyacente

En la tabla 3.3 se muestran los 
resultados del mallado variando el MRER, 
manteniendo Element size en 4 mm y los demás 
parámetros por defecto. Puede observarse que, 

efectivamente, reducir este parámetro acerca 
la medida de calidad hacia el valor teórico, a 
expensas de un crecimiento no lineal de la 
cantidad de elementos. En las imágenes de 
los cortes se percibe cómo los elementos van 
aumentando su tamaño a medida que se alejan 
de la superficie, y que con la reducción del 
MRER se vuelven más pequeños y uniformes.

El fémur tiene una configuración 
optimizada para las cargas fisiológicas, 
produciéndose los valores y gradientes de 
esfuerzos más altos en la superficie. En el 
interior del hueso ambos factores son menores, 
por lo que una distribución de elementos 
con aumento de tamaño gradual hacia el 
interior es adecuada si se van a simular cargas 
superficiales. Cuando el objetivo es simular 
la interacción entre el interior del hueso y 

dispositivos artificiales, como clavos, tornillos 
y prótesis internas, se debe refinar más el 
mallado interno.

La configuración por defecto del 
MRER produce una distribución adecuada 
de los elementos con valores aceptables de 
calidad, por lo que la malla volumétrica con la 
que se trabajará será la primera, con 24 834 
elementos.

Tabla 3.3. Efecto de la variación del parámetro Minimum radius-edge ratio en las características de las 
mallas volumétricas.
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4.	 ESTUDIO DE CASO:                      
MODELO HOMOGÉNEO

Para crear el modelo homogéneo 
se sigue trabajando con        FEBio Studio, 
tratando los tejidos como elásticos, lineales 
e isotrópicos, e incorporando propiedades 
mecánicas constantes a los elementos de la 
malla volumétrica.

 4.1	  Propiedades homogéneas
Para garantizar la consistencia de 

las unidades en FEBio Studio, seleccionar el 
menú Tools → Options … En la lista del panel 
izquierdo, seleccionar la opción Units y en la 
lista Unit system seleccionar mm-N-s. Terminar 
la configuración presionando OK.

Figura 4.1. Visor del modelo en FEBio Studio después de asignarle propiedades 
homogéneas. 

Para crear el material, en la ventana 
del visor del modelo se selecciona la opción 
Materials con el botón derecho del ratón y en el 
menú contextual se selecciona Add Material… 
En el campo Name se le asigna un nombre 
descriptivo, y en el campo Filter se escribe 
isotropic. De la lista filtrada se selecciona 
isotropic elastic y se hace clic en OK.

4.   ESTUDIO DE CASO: MODELO HOMOGÉNEO
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En la opción Materials del visor del 
modelo aparecerá una entrada con el nuevo 
material; al seleccionarla con el botón izquierdo 
del ratón, en la parte inferior aparecerán tres 
zonas llamadas Info, Properties y Selection. 
El nombre y el color del material se pueden 
cambiar en el campo Info. En Properties hay 
tres campos en los que se deben escribir las 
propiedades del material, density, Young’s 
modulus y Poisson’s ratio; las unidades de los 
primeros dos campos son tonnes/mm3 y MPa. 
Para este ejemplo se puede ignorar el campo 
de la densidad, ya que solamente es relevante 
en simulaciones dinámicas o si se va a tomar 
en cuenta el peso propio; el módulo de Young 
se fija en 13 000 MPa y la relación de Poisson 
en 0,3. En Selection se debe indicar la parte a 
la que se le asignarán las propiedades. Para 
ello, se hace clic en el botón Select parts , se 
señala la malla volumétrica y luego el botón 
Add selection . De esta manera se finaliza la 
asignación homogénea de propiedades y debe 
dar como resultado un esquema en el visor del 
modelo similar al de la figura 4.1.

 4.2	  Aplicación de las condiciones de 	
	  contorno

En esta sección se expone el 
procedimiento para aplicar las fuerzas y 
restricciones en el modelo. En ambos casos, 
homogéneo y heterogéneo, se sigue el 
mismo procedimiento general, pero con las 
particularidades de cada software, FEBio 
Studio para el primero y Ansys Student para 
el segundo. También es común a ambos 
programas el tener que seleccionar los nodos 
o, alternativamente, las caras externas de los 
elementos superficiales para la aplicación 
de las condiciones de contorno, porque en 
ninguno de los dos modelos existen objetos 

tipo superficie que puedan ser seleccionados. 
En cualquiera de los dos programas, la 
selección de nodos o de caras superficiales 
se realiza empleando la interfaz gráfica, con 
las imprecisiones que esto implica, pero es 
igualmente cierto que ambos programas 
permiten la inclusión de instrucciones escritas 
para la selección precisa de nodos y elementos, 
por lo que es factible incrementar la precisión 
del modelo si la investigación lo amerita.

 4.3	  Condiciones de contorno en el mo-	
	  delo homogéneo

Al seguir los procedimientos de 
las secciones 3.3.2, 3.3.3 y 4.1, se tienen ya 
definidos en FEBio Studio la física por simular, 
la malla volumétrica y el material. La siguiente 
fase es crear un paso de análisis, ya que el 
programa genera uno inicial, pero que no es 
suficiente para que el proyecto se considere 
listo para simular.

4.3.1	  Creación de un paso de análisis
En el visor del modelo dirigirse a la 

opción Steps, que debe estar acompañada 
por un símbolo de advertencia  . Hacer 
clic con el botón derecho del ratón y 
seleccionar Add Analysis Step. Se agregará 
un paso que por defecto se llama Step1 y 
en la parte inferior aparecerá un panel con 
propiedades que se pueden configurar, como 
el nombre del paso y las características del 
solucionador no lineal. En general, se puede 
dejar la configuración por defecto.

4.3.2	  Aplicación de restricciones en      	
	  FEBio Studio

Si se despliegan los pasos Initial y Step1 
se advierten dos listas idénticas de opciones, 
entre las que se encuentran Boundary conditions 

y Loads. Las configuraciones que se definan en el 
paso inicial serán aplicadas en todas las etapas 
de análisis, mientras que las que se configuren 
en cualquier otro paso solo se aplicarán allí, 
como se explica en la figura 4.2.

Figura 4.2. Pasos de análisis y sus ámbitos de 
influencia.

Las cargas y restricciones se definirán 
en el Step1, aunque en este caso se pueden 
definir en Initial con el mismo efecto. 
Seleccionar con el botón derecho del ratón la 
opción Boundary Conditions y seleccionar Add 
Nodal BC … En la caja de diálogo que emerge 
configurar el nombre como “Fijo”, en la lista 
desplegable de Step seleccionar Step1 y en 
la lista Type seleccionar Zero displacement. 
Luego de hacer clic en Ok, debajo del visor 
del modelo aparece un panel para configurar 
la restricción. En la sección Properties, 
habilitar las restricciones x displacement, y 
displacement y z displacement.
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Figura 4.3. FEBio Studio: selección de nodos para restricción de 
desplazamientos en el extremo distal.

Ahora corresponde seleccionar los 
nodos sobre los que se aplicará la restricción. 
Para ello, orientar el modelo presionando la 
tecla “2” del teclado numérico del computador, 
hacer clic en el botón Select Objects  y 
seleccionar el modelo; en la barra ubicada 
debajo de la ventana gráfica aparecerán nuevos 
botones. Hacer clic en Select nodes  y en 
Select backfacing  para habilitar la selección 
de nodos. En la barra sobre la ventana gráfica, 
hacer clic en el botón Rectangle  , presionar 
simultáneamente la tecla “Mayúsc” (Shift) y el 
botón izquierdo del ratón para desplegar una 
región rectangular de selección de los nodos 
en la parte inferior de la malla. Al soltar ambos 
botones se realiza la selección de los nodos. En 
la imagen izquierda de la figura 4.3 se muestra 
el proceso de selección y en la imagen derecha 
el resultado final.

Los nodos seleccionados deben añadirse 
a la configuración de la restricción. En la sección 
Selection, presionar el botón Add selection  ; 
en el área en blanco aparecerá una entrada 
similar a [ítems: 306] que informa el número de 
nodos seleccionados. En el campo Type deberá 
mostrar que los objetos seleccionados son del 
tipo Nodes. Finalmente, hacer clic en cualquier 
parte del fondo de la ventana gráfica para 
desmarcar los nodos y evitar que se añadan a la 
próxima selección.

4.3.3	  Aplicación de fuerzas en FEBio Studio
Para ilustrar la aplicación de fuerzas 

se aplica una carga sobre la cabeza del fémur 
con una dirección tal que el esfuerzo máximo 
se ubica en la región inferior del cuello, 
correspondiente al peso de una persona de 

Figura 4.4. FEBio Studio: nodos seleccionados para la aplicación 
de la fuerza en la cabeza del fémur.

90 kg multiplicado por un factor de impacto 
de 3, como en el caso de bajar una escalera. 
El procedimiento es similar al de aplicar las 
restricciones; se comienza haciendo clic con 
el botón derecho del ratón en la opción Load 
del paso 1 y seleccionando Add Nodal Load … 
En la caja de diálogo que aparece configurar el 
nombre como “Fuerza”, en la lista desplegable 
de Step seleccionar Step1 y en la lista Type 
seleccionar Nodal force. Luego de hacer clic 
en Ok, debajo del visor del modelo aparece un 
panel para configurar la fuerza. En el campo 
value de la sección Properties introducir los 
componentes de la fuerza, en newton, como 
un trío de números:{ 501.3, 52.32,  2599}. La 
selección de los nodos sobre los que se aplica la 
fuerza para incluirlos en la sección Selection se 
realiza siguiendo el mismo procedimiento que 
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para aplicar las restricciones, pero con nodos 
ubicados en la parte superior de la cabeza del 
fémur. En la figura 4.4 se muestran los nodos 
seleccionados.

FEBio Studio asocia un objeto llamado 
controlador de carga (Load controller) tanto 
a las restricciones como a las cargas, que 
regula la forma en que las condiciones de 
borde se van aplicando a medida que avanza el 
análisis. Se debe recordar que el solucionador 
FEBio trabaja únicamente en modo no lineal, 
y por defecto las cargas y desplazamientos 
impuestos se aplican gradualmente. El 
controlador permite configurar si las cargas 
se aplican en incrementos lineales, no lineales, 
y escalones, entre otras opciones. En el caso 
de restricciones fijas, el controlador de carga 
se mantiene oculto y el programa lo maneja 
internamente. Para la fuerza que se ha 
configurado en este ejemplo, el controlador se 
crea automáticamente con el nombre LC1; es 
necesario verificarlo porque el modelo no se 
puede simular si el controlador no existe. Para 
ello, seleccionar la entrada Load controllers → 
LC1 en el visor del modelo; debe observarse un 
gráfico como el de la figura 4.5.

Se aprecia que, por defecto, la curva de 
carga es lineal y va desde el punto (0, 0) hasta 
el punto (1, 1). El eje horizontal representa las 
etapas o subpasos del paso de carga, mientras 
que el eje vertical corresponde a la cantidad de 
carga aplicada, con el valor 1 representando 
el 100 %. En la sección Properties pueden 
modificarse las características de la curva de 
carga, aunque en este caso no es necesario 
porque en la sección 4.3.1 se configuró el paso 
inicial para que se resolviera el problema en 
una sola etapa.

Figura 4.5. Controlador de carga para la fuerza aplicada al modelo.

 4.4	  Simulación del modelo homogéneo
Este proceso se realiza en tres 

etapas: la configuración de los resultados 
deseados, inicio de la solución del modelo, y la 
visualización de los resultados.

4.4.1	  Configuración de los resultados re-	
	  queridos en FEBio Studio

Antes de resolver el modelo, se deben 
especificar los resultados deseados. Para ello, 
en el visor del modelo seleccionar la opción 
Output → plotfile. Las opciones activadas 
por defecto son los desplazamientos, 
los esfuerzos y el volumen relativo. Los 

primeros dos son resultados que en general 
son requeridos en todos los análisis de 
elementos finitos. Si se requieren las 
deformaciones o la energía de deformación, 
que es un parámetro usado con frecuencia 
para realizar análisis de convergencia de la 
malla, se debe seleccionar Edit plot variables 
… y activar las opciones correspondientes en 
la siguiente caja de diálogo. Si se desean las 
fuerzas de reacción, en lugar de la restricción 
del tipo Zero displacement se debe aplicar el 
tipo Prescribed displacement con valor cero, 
uno por cada grado de libertad, configurar el 
controlador de carga para cada restricción, 
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y activar reaction forces en la caja de diálogo 
de Edit plot variables …

4.4.2	  Solución del modelo homogéneo
En la barra de botones superior, 

presionar Run FEBio   o la tecla “F5”. 
En la caja de diálogo emergente, dejar la 
configuración por defecto y presionar el 
botón “Run”. Al finalizar la solución aparece 
una nueva caja de diálogo informando que el 
proceso terminó normalmente y preguntando 
si desea cargar los resultados. Responda Yes; se 
abre una ventana gráfica en una nueva pestaña 
con el ambiente de postproceso.

4.4.3	  Visualización de los resultados en 	
	  FEBio Studio

Por defecto, FEBio Studio muestra los 
resultados del paso 0, que es el inicial, por lo 
que si se intenta desplegar algún resultado 

Figura 4.6. Desplazamientos y esfuerzos en el modelo homogéneo simulado con FEBio Studio.

parecerá que no se ha realizado la simulación. 
Para observar los resultados del último paso 
de carga, que son los de interés, presionar el 
botón last   en la barra de botones superior. 
Activar el mapa de color presionando el botón 
Toggle colormap . En la parte inferior del 
panel izquierdo (Post) se activa la ventana 
Properties, en la que se pueden configurar 
varias características de la visualización.

En la propiedad Data field se elige 
el resultado deseado. Se puede seleccionar 
displacements → displacement Magnitude para 
ver la resultante de los desplazamientos, o stress 
→ Effective stress para ver el esfuerzo equivalente 
de von Mises, entre otros resultados. El mapa de 
color, Color map, se encuentra por defecto como 
Hot Cold, pero se puede cambiar a Jet para una 
visualización de colores más familiar. La leyenda 
está dividida en diez niveles por defecto, pero 
en Range divisions se puede cambiar a otro 

valor. Finalmente, en Show min/max markers se 
puede configurar la visualización de un par de 
puntos en las ubicaciones de los valores máximo 
y mínimo, con los colores que corresponden 
según el mapa de color activo. En la figura 4.6 se 
aprecian las imágenes de los desplazamientos 
y los esfuerzos con algunas de las propiedades 
de visualización modificadas respecto a la 
configuración por defecto.

El ambiente de post procesamiento 
de FEBio Studio tiene más opciones de 
visualización, como gráficos de vectores, 
tensores e isosuperficies, entre otros. También 
se pueden crear animaciones  y cortes para 
observar la distribución interna de los 
resultados. La mejor fuente de información es el 
manual de FEBio Studio, al que se puede acceder 
a través del menú de ayuda del programa.

Respecto a la visualización por defecto, estas 
imágenes tienen los siguientes cambios: color del 
fondo y del texto, malla oculta, mapa de color Jet, 
marcadores activados de máximo/mínimo, doce 
divisiones en la leyenda.
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omitirse. Las tres últimas líneas del archivo 
deben verse así:

Abrir Bonemat, que por defecto crea 
un proyecto nuevo, y guardarlo con un nombre 
descriptivo (File → Save). A continuación, 
importar las imágenes tomográficas haciendo 
clic en File → Import → Images → DICOM. 
Navegar hasta el directorio en el que se 
encuentran las imágenes y seleccionarlo. 
Esta acción inicia el importador de imágenes 
DICOM, mostrado en la imagen izquierda de la 
figura 5.1. Se debe asegurar que en el campo 
VME output esté seleccionada la opción Volume, 
y luego hacer clic en el botón Crop >. En el 
siguiente paso del importador, imagen derecha 
de la figura 5.1, dejar seleccionada solamente 
la opción Description del campo Name para 
acortar el nombre mostrado; terminar el 
proceso haciendo clic en Finish.

El siguiente paso es importar la malla 
volumétrica. Hacer clic en File → Import → 
Finite Element → Abaqus File, seleccionar y 
abrir el archivo modificado previamente. Al 
terminar ambos procedimientos, a la derecha 
de la interfaz, en el panel de control (Control 
Panel) con la pestaña Data tree seleccionada, 
debe aparecer el objeto Root y dos objetos 
“hijos”, uno de volumen llamado Femur 1.0 
B20s, y otro de malla con el mismo nombre 

5.	 ESTUDIO DE 
CASO: MODELO      
HETEROGÉNEO	

El modelo heterogéneo se construye 
usando la malla volumétrica creada con FEBio 
Studio. Al igual que en el caso homogéneo, los 
tejidos se modelarán como elásticos, lineales e 
isotrópicos, pero el módulo de elasticidad será 
una función de la información proporcionada 
por las tomografías, utilizando el programa 
Bonemat.

 5.1	  Propiedades heterogéneas
Con la malla volumétrica cargada en 

FEBio Studio, navegar a la opción de menú 
File → Export Geometry…, asignar un nombre 
a la malla y exportarla en el formato Abaqus 
files *.inp. Este formato y el vtk son los únicos 
soportados en común por FEBio Studio y 
Bonemat, pero el formato vtk no permite la 
asignación de materiales y, aunque Bonemat 
lee la malla, al intentar visualizarla con las 
propiedades heterogéneas se produce un error 
y el programa se cierra. Luego de exportar la 
malla se puede cerrar FEBio Studio porque no 
se seguirá utilizando.

La malla exportada en el formato de 
Abaqus no puede utilizarse directamente. 
FEBio Studio no agrega la sección de materiales, 
mientras que Bonemat la espera para este tipo 
de archivos y, si no la encuentra, se produce un 
error de sintaxis y se cierra el programa. Para 
resolver este inconveniente, abrir el archivo de 
la malla con un editor básico para texto ASCII, 
y en la penúltima línea del archivo, antes del 
comando *END STEP, insertar la instrucción 
“*MATERIAL,”. La coma después de la palabra 
MATERIAL es parte de la instrucción y no puede 

que el archivo en el que se guardó la malla 
volumétrica.

Para verificar que todos los datos están 
correctos, crear una visualización haciendo 
clic en View → OrthoSlice. En este momento, al 
lado de cada objeto hijo aparecerá una caja de 
selección. Si se selecciona la caja del volumen de 
imágenes, aparecerán vistas de la tomografía, 
como se observa en la figura 5.2, que muestra 
solamente el área gráfica de la interfaz para 
maximizar las imágenes de interés. En la caja 
superior izquierda se observa una vista 3D de las 
imágenes proyectadas en los planos transversal, 
coronal y sagital, y en las otras tres cajas se 
presentan las vistas planas de los planos. Las 
asas rojas, verdes y azules permiten manipular 
la posición de los planos para cambiar la parte 
observada de la tomografía.

5.   ESTUDIO DE CASO: MODELO HETEROGÉNEO
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Figura 5.2. Visualización de las imágenes tomográficas en Bonemat.

Figura 5.1. Importador de imágenes DICOM de Bonemat.

Al seleccionar adicionalmente la caja 
del objeto de malla, se superpondrá la malla 
volumétrica a las imágenes tomográficas 
siempre que ambas compartan el mismo sistema 
de referencia, como se advirtió en la sección 
2.4.1. En la figura 5.3 se observa la coincidencia 
completa de ambos grupos de datos.

Si por alguna circunstancia no 
coincidieran la malla y la tomografía, Bonemat 
dispone de la operación Transform, que permite 
trasladar, rotar y escalar la malla, así como 
mover el origen del sistema de referencia. Esta 
operación debe realizarse antes de desarrollar 
la próxima fase.
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Figura 5.3. Malla volumétrica superpuesta a las imágenes tomográficas 
en Bonemat.

Figura 5.4. Activación de la operación Bonemat.

El siguiente paso es generar las 
propiedades heterogéneas del tejido óseo. 
Para ello, en el Data tree se debe seleccionar el 
nombre del objeto de malla para que se habilite 
la opción de menú Operations → Bonemat, que es 
el núcleo de la funcionalidad de este programa. 
En la figura 5.4 se ilustra el procedimiento.

En el panel de control se activa ahora la 
pestaña Operation; para facilitar la descripción 
y observar mejor los detalles se dividió el panel 
en tres partes. En la figura 5.5 se muestra la 
primera parte del panel, ya con los parámetros 
introducidos.

En la sección Configuration File se 
dispone de las funciones para guardar y cargar 
los parámetros de la operación Bonemat. Esto 
es conveniente para no tener que ingresar 
repetidamente los datos.

En la sección CT densitometric 
calibration se introducen los parámetros que 
relacionan los valores de unidades Hounsfield 
con la densidad aparente radiológica. En este 
caso, las cantidades a y b son referenciales 
de forma que se obtienen las densidades en 
unidades de gramos por centímetro cúbico, 
pero si se usó un patrón de calibración, como 
se mencionó en la sección 2.1.1, los valores de 
a y b son los que corresponden a la curva de 
calibración del tomógrafo.

Figura 5.5. Operación Bonemat: archivo de confi-
guración y calibración densitométrica.
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Figura 5.6. Operación Bonemat: relación densi-
dad-elasticidad.

Figura 5.7. Operación Bonemat: parámetro de 
integración y configuración avanzada.

Los siguientes dos grupos, Correction of 
the calibration y RhoAsh -> RhoWet Conversion, se 
especifican dependiendo de si la relación entre 
la densidad del tejido y el módulo de elasticidad 
es una función de la densidad de ceniza o 
de la densidad aparente húmeda, descritas 
en la sección 1.4.2. En este caso se utilizará 
la fórmula de Keller [29], ver tabla 1.1, que 
depende directamente de la densidad aparente 
radiológica, por lo que no se configuran.

En la sección Density-elasticity 
relationship, figura 5.6, se especifica el módulo 
de elasticidad como una función de la densidad 
aparente. Los parámetros se escribieron de 
forma que para densidades en unidades de 
gramos por centímetro cúbico se obtienen 
módulos de elasticidad en megapascales. 
Los primeros dos campos permiten definir 

los valores mínimo y máximo del módulo 
de elasticidad. Los valores por defecto se 
interpretan como 1 pascal (10-6 megapascales) 
y 1 terapascal (106 megapascales) por lo que 
no influirán en los módulos calculados, que 
estarán holgadamente dentro de ese rango.

A continuación, se encuentra una lista 
desplegable con las opciones Single Interval 
y Three intervals. La primera sirve para 
especificar una sola relación aplicable a todo el 
rango de densidades, mientras que la segunda 
permite especificar relaciones diferentes a 
cada uno de los tres rangos definidos por dos 
densidades límite, Rho1 y Rho2. Esta última 
opción es útil para dividir el hueso en las 
regiones de canal medular, tejido trabecular 
y tejido cortical. El valor de Rho1 = 0,9 g/cm3 

separa a lo que se considera médula del tejido 
trabecular, y el valor Rho2 = 1,2 g/cm3 divide al 
tejido trabecular del cortical. 

Los parámetros a, b y c del primer 
intervalo, para la médula, definen un módulo 
de elasticidad constante equivalente a 100 MPa. 
Sin embargo, debido a que la fórmula de Keller 
[29] es válida tanto para el tejido trabecular 
como para el cortical, el segundo y tercer 
intervalo mantienen los mismos parámetros. 
De esta manera, el módulo de elasticidad más 
bajo será de 2100 MPa mientras que el más alto 
será de aproximadamente 13 000 MPa, ya que 
la densidad máxima es de 2 g/cm3.

En el campo Bonemat integration 
parameter, figura 5.7, se tiene dos opciones, 
HU integration y E integration. Debido a que el 
volumen de un elemento finito abarca varios 
vóxeles, cada uno con su propio valor de 
unidades Hounsfield, el módulo de elasticidad 
de cada elemento debe calcularse como un 
promedio. Este promedio se puede calcular 
con uno de varios parámetros: el módulo de 

elasticidad, las unidades Hounsfield (HU), o la 
densidad aparente. Las primeras dos opciones 
son ofrecidas por Bonemat, y la última es 
la utilizada en el trabajo de San Antonio et 
al. [3]. La diferencia entre seleccionar una u 
otra opción en Bonemat no es despreciable 
porque la relación entre E y HU no es lineal. 
En principio, es preferible seleccionar las 
unidades Hounsfield porque es el parámetro 
más cercano a la densidad, que es una 
propiedad física del material.

El promedio se calcula integrando en el 
volumen del elemento finito, pero no se toman en 
cuenta todos los vóxeles, sino solamente algunos 
puntos de integración dentro del volumen, que 
es lo que se especifica en Integration steps.

Dependiendo de la configuración, 
Bonemat puede calcular hasta tres tipos de 
densidad. Density Output controla cuál densidad 
se escribirá en el archivo de salida. Finalmente, 
la relación de Poisson se considera constante 
respecto a la densidad, por lo que su valor se 
especifica en Poisson’s Ratio.
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Luego de llenar toda la información, se 
recomienda pulsar el botón Save configuration 
file as para guardarla, y terminar el proceso con 
el botón Ok. En el panel de control aparecerá un 
objeto nuevo con el nombre de la malla más el 
sufijo Bonemat.

Para ver el efecto de la operación 
Bonemat, volver a la visualización OrthoSlice 
y seleccionar solamente el objeto de volumen 
de imágenes y el objeto nuevo con Bonemat. 
Luego, hacer clic en el nombre del objeto con 
Bonemat y en la pestaña Visual props, habilitar 
Enable scalar field mapping, desplegar la lista 
y seleccionar la opción [CELL] EX si se desea 
observar el módulo de elasticidad, o [CELL] 
DENS para ver la distribución de densidad. Los 

pasos se presentan en la figura 5.8. 
Al finalizar el procedimiento se deben 

obtener gráficos similares a los de la figura 5.9. 
Se puede dejar de visualizar las aristas de la 
malla deshabilitando la opción Element Edges 
de la pestaña Visual props.

Para hacer énfasis en la vista 3D sin 
dejar de ver los cortes, seleccionar la pestaña 
View settings del panel de control y en la lista 
Layout, seleccionar Layout 1 o Layout 2.

La visualización View → Surface 
permite acceder a información de interés. 
Como su nombre lo indica, muestra solamente 
la superficie del modelo, pero en la pestaña 
Visual props se habilita la opción Show scalar 
bar. Al seleccionarla, aparece una barra con 

Figura 5.8. Configuración de la visualización de la 
heterogeneidad del modelo.

valores de módulo de elasticidad o de densidad, 
dependiendo de la elección en la lista de Enable 
scalar field mapping. En este caso, los valores 
extremos del módulo de elasticidad son 2,3.103 

y 1,23.104, en megapascales, como se muestra 
en la figura 5.10.

Figura 5.9. Vista 3D y cortes del modelo con propiedades elásticas hetero-
géneas.
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Figura 5.10. Visualización de superficie con la barra de valores del módulo de 
elasticidad.

Para exportar la información, se 
debe seleccionar el nombre del objeto con 
Bonemat, navegar al menú File → Export → 
Finite Element → Ansys CDB File. En el panel 
de control se activa la pestaña Operation 
con algunas preferencias configuradas por 
defecto. La opción Elasticity Gap Value es 
la más interesante, ya que define el número 
de materiales que se crearán para el modelo 
heterogéneo. Para ello se divide la diferencia 
entre los valores máximo y mínimo del módulo 
de elasticidad entre el Elasticity Gap Value, y 
este resultado será el número aproximado de 
materiales diferentes que se generarán en el 
modelo. Por ejemplo, en el caso en estudio 
la diferencia entre el máximo y el mínimo 
es de 104 MPa, y al dividir por un Elasticity 
Gap Value de 100, se deberían obtener 100 
materiales diferentes. Definidos todos los 

Project Schematic y hacer doble clic en Setup. 
Se mostrará la pestaña A: External Model; 
presionar en los tres puntos de la celda B2, 
navegar hasta el archivo CDB y cargarlo. En la 
celda A2 se mostrará ahora la ruta de acceso 
y el nombre del archivo; seleccionarla para 
que en la parte inferior se muestre la ventana 
Properties of File. Verificar que en la opción 
Application source se encuentre seleccionado 
MAPDL; seleccionar el sistema Metric 
(kg,mm,s,°C,mA,N,mV) en la lista de Unit System, 
y desactivar la opción Check Valid Blocked CDB 
File. Terminada esta configuración, volver a la 
pestaña Project.

Al lado de Setup, en la celda A2 del 
modelo externo, debe verse un rayo amarillo 

 . En la barra de botones superior, presionar 
Update Project para leer el archivo CDB, y ahora 
al lado de Setup debe aparecer una marca 
de verificación verde  . A continuación, 
arrastrar un sistema Static Structural hasta 
el esquema del proyecto, a la derecha del 
modelo externo, para comenzar a compartir la 
información entre ambos componentes.

El sistema Static Structural tiene seis 
componentes: Engineering Data, Geometry, 
Model, Setup, Solution, y Results. Este sistema 
creará un material por defecto, Structural 
Steel, que se puede eliminar haciendo doble 
clic en Engineering Data y borrándolo de la 
lista de materiales, pero que también se puede 
dejar sin que afecte al modelo. El archivo 
CDB contiene dos tipos de información: la 
malla (nodos y elementos), y los materiales. 
Cuando se comparta esta información con 
el sistema Static Structural, el componente 
Geometry desaparecerá porque se importará 
directamente la malla al componente Model. 
Para transferir los datos, se hace clic en Setup del 
modelo externo y se arrastra hasta Engineering 

parámetros, se presiona Ok para finalizar la 
operación, se le asigna un nombre al archivo y 
se guarda. En el archivo que se genera para el 
caso en estudio se definen efectivamente 100 
materiales diferentes.

 5.2	  Condiciones de contorno en el mo-	
	  delo heterogéneo

Para crear el modelo se debe importar 
en Ansys Workbench / Mechanical el archivo 
con extensión CDB creado con Bonemat; este no 
es un procedimiento trivial porque ese formato 
se considera antiguo (legacy).

5.2.1	  Importación del modelo heterogé-	
	  neo en Ansys Workbench

Abrir Workbench y guardar el proyecto 
con un nombre descriptivo. Del panel Toolbox, 
arrastrar el componente External Model al área 
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Data del Static Structural. Debe aparecer una 
línea morada conectando ambos componentes. 
Se repite ahora la operación, haciendo clic 
en Setup y arrastrándolo hasta Model, debe 
aparecer una segunda línea de conexión y 
desaparecer el componente Geometry del Static 
Structural. El esquema del proyecto debería ser 
ahora similar al de la figura 5.11.

Se deben configurar algunas opciones 
del modelo antes de editarlo. Seleccionar el 
componente Model del sistema Static Structural, 
y a la derecha del área Project Schematic debe 
aparecer la ventana Properties of Schematic B3: 

Model. En la sección Mesh Conversion Options, 
deshabilitar la opción Create Geometry, y en 
Body Grouping deshabilitar la opción Material 
Number y habilitar Ansys Element Type Number.

Para que se produzca efectivamente 
la transferencia de datos y se actualice la 
configuración del modelo, presionar de nuevo 
el botón Update Project. Aparecerá una caja de 
diálogo ofreciendo consolidar los materiales 
porque el tiempo de importación puede 
ser largo. Seleccionar la opción No porque 
la consolidación de materiales afecta los 
resultados de esfuerzos y desplazamientos. 

Luego de esperar el tiempo necesario, el 
sistema se encuentra actualizado y listo para 
ser editado. Hacer doble clic en Setup del 
sistema estructural y esperar a que abra Ansys 
Mechanical. La importación deberá ocurrir sin 
problemas, y la ventana con el esquema del 
proyecto no debería mostrar ningún error; 
inicialmente el modelo se verá muy pequeño y 
deberá hacerse un acercamiento (Zoom in) para 
poder observarlo. En la figura 5.12 se presenta 
cómo debe verse el modelo y el esquema del 
proyecto al finalizar este paso. 

Figura 5.11. Esquema del proyecto luego de conectar el com-
ponente External Model con el sistema Static Structural.

Figura 5.12. Modelo cargado en Ansys Mechanical.
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Figura 5.13. Ansys Mechanical: selección de nodos para restricción de 
desplazamientos en el extremo distal.

Figura 5.14. Ansys Mechanical: nodos seleccionados para la aplica-
ción de la fuerza en la cabeza del fémur.

5.2.2	  Aplicación de restricciones en 		
	  Ansys Mechanical

Seleccionar el nodo Static Structural 
(B4) del esquema del proyecto con el botón 
derecho del ratón. Desplegar la lista en Insert 
y seleccionar Fixed Support para agregarlo al 
esquema del proyecto. Al hacer clic sobre este 
elemento, en la parte inferior del panel se verá 
Details of “Fixed Support”, que es donde se deben 
especificar los nodos o elementos a los que se le 
aplicará la restricción.

En este caso se seleccionarán nodos. Si 
se hace clic sobre el eje Y (verde) del sistema de 
referencia, el modelo se orienta con una vista 
sobre el plano XZ, lo cual facilitará la selección. 
En la barra que se encuentra sobre la ventana 
gráfica se encuentra el botón para activar la 
selección de nodos  . También hay un botón 
para elegir el modo de selección; por defecto 

del ratón, se despliega la lista en Insert y se 
selecciona Force para agregarlo al esquema 
del proyecto. Al hacer clic sobre este elemento, 
en la parte inferior del panel se verá Details of 
“Force”, que es donde se deben especificar las 
características de la fuerza, así como los nodos 
o elementos sobre los que se distribuirá.

La selección de nodos sigue un 
procedimiento similar al utilizado en la 
parte distal, pero ahora se despliega el 
rectángulo en la parte superior de la cabeza 
del fémur. Una vez seleccionado los nodos, se 
agregan a la selección presionando el botón 
Apply de la opción Geometry en el panel de 
configuración de la fuerza; luego de presionar 
el botón, es sustituido por el número de nodos 
seleccionados, 174 en este ejemplo. En la figura 
5.14 se muestran los nodos seleccionados.

se encuentra en Single Select y se debe cambiar 
a Box Volume Select  . Desplegar un 
rectángulo usando el ratón para seleccionar 
los nodos en la zona distal del modelo. En la 
imagen izquierda de la figura 5.13 se muestra el 
proceso de selección y en la imagen derecha los 
nodos seleccionados. A continuación, presionar 
el botón Apply de la opción Geometry en el panel 
de configuración del soporte fijo para agregar 
los nodos a la selección; luego de presionar el 
botón, será sustituido por el número de nodos 
seleccionados, 309 en este caso.

5.2.3	 Aplicación de fuerzas en Ansys M	
	 echanical

Se modelará una fuerza con las mismas 
características que en FEBio Studio. Se vuelve 
a seleccionar el nodo Static Structural (B4) del 
esquema del proyecto con el botón derecho 
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En el mismo panel, en Definition, en 
la lista de Define by seleccionar Components; 
aparecerán tres campos, uno para cada 
componente en las tres direcciones 
rectangulares. Introducir los mismos valores 
que en FEBio Studio,  -501,3 N en X, 52,32 N en 
Y, y -2599 N en Z.

 5.3	  Simulación del modelo heterogéneo
En este proceso se realizan las mismas 

tres etapas que se siguieron con el modelo 
homogéneo: la configuración de los resultados 
deseados, inicio de la solución del modelo, y la 
visualización de los resultados.

5.3.1	  Configuración de los resultados 	
	  requeridos en Ansys Mechanical

Para especificar los resultados 
deseados, hacer clic con el botón derecho 
del ratón sobre el nodo Solution (B5) y 
seleccionar Insert → Deformation → Total. 
Luego seleccionar Insert → Stress → Equivalent 
(von-Mises). Ambos resultados están ahora 
incluidos en el esquema del proyecto, debajo 
del nodo Solution (B5). Si se desea obtener las 
fuerzas de reacción, se puede insertar Probe → 
Force Reaction.

5.3.2	  Solución del modelo heterogéneo
Hacer clic con el botón derecho del 

ratón sobre el nodo Solution (B5) y seleccionar 
el botón Solve  , o presionar la tecla “F5”. 
Finalizada la solución, los rayos amarillos a la 
izquierda de Total Deformation y Equivalent 
Stress son sustituidos por marcas de verificación 
verdes.

5.3.3	  Visualización de los resultados en 	
	  Ansys Mechanical

Ansys muestra por defecto los 
resultados del paso final de carga. Al 
seleccionar Total Deformation se muestra la 

Figura 5.15. Desplazamientos y esfuerzos en el modelo heterogéneo simulado con Ansys Mechanical.
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resultante de los desplazamientos, como se 
aprecia en la imagen izquierda de la figura 
5.15, y en Equivalent Stress se presenta el 
esfuerzo equivalente de von Mises, mostrado 
en la imagen derecha de la misma figura.

En Ansys, la selección de colores 
se denomina Color Scheme y por defecto 
se muestra el esquema Rainbow, que es el 
equivalente al mapa Jet de FEBio Studio. En 
la pestaña Results de la cinta de botones, que 
se activa al seleccionar el nodo Solution (B5) 
o cualquiera de los resultados, se encuentra 
el botón con lista desplegable Edges  , que 
permite ocultar la malla (No Wireframe), y 
los botones Maximum   y Minimum 

, que al activarlos muestran la 
ubicación y magnitud de los valores máximos 
y mínimos de los resultados. Finalmente, al 
seleccionar el primer cuadro de la leyenda 
aparecen los botones “+” y “–“, lo cual permite 
incrementar o disminuir el número de 
divisiones.

 5.4	  Comparación de resultados y re-	
	  flexiones finales

El modelo heterogéneo es más flexible 
que el homogéneo, con un desplazamiento 
67,5 % superior, que es lo esperado porque la 
mayoría de los elementos tienen propiedades 
elásticas más bajas que el máximo cortical. 
El esfuerzo también es mayor, aunque con 
una diferencia menor, de alrededor del 24 %. 
Debe tomarse en cuenta que los resultados se 
obtuvieron con diferentes programas y este 
factor también puede influir en las diferencias, 
y una comparación mejor podría hacerse si se 
simulara el modelo homogéneo en Ansys.

Ambos programas tienen amplias 
capacidades que permiten la simulación de 
elementos biológicos y tienen limitaciones 

en sus funcionalidades que pueden ser 
temporales: el pago de la licencia de Ansys 
liberaría las restricciones de tamaño, y un 
programa de desarrollo propio que convierta el 
archivo CDB, creado por Bonemat y destinado 
a Ansys, en un archivo de modelo para FEBio 
Studio facilitaría la simulación del modelo 
heterogéneo en este programa.
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